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1 Printer Functions

1.1 Overview of printer functions
The printer driver is software that specifies how to use the printing functions of this machine from other ap-
plication software. When you install the printer driver on your computer, you can use a variety of this ma-
chine’s printing functions. Furthermore, the printer driver supports a wide range of connection methods and 
provides flexibility in various environments.

It also supports direct printing, a printing method that does not use the printer driver, and printing from a USB 
memory device.
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1.2 System requirements

For Windows

For Mac OS

dReference
For details on how to use the Linux printer driver, refer to Chapter 5 "Printing in the Linux Environment" in 
[User's Guide Applied Functions].

Item Specifications

Operating system The supported versions of the operating system vary depending on the installed 
printer driver. For details, refer to page 2-5.

CPU Any processor of the same or higher specifications as recommended for your oper-
ating system

Memory Memory capacity as recommended for your operating system
The memory space must be enough for the OS and applications used.

Drive CD-ROM drive

Item Specifications

Operating system Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x, 10.7.x, 10.8.x)

CPU PowerPC, Intel Processor

Memory Memory capacity as recommended for your operating system

Drive CD-ROM drive
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1.3 Cable connection ports of this machine
The printer cables are connected to each port on this machine.

No. Port Description

1 USB port Use a USB interface cable for USB connection.
Use a type A (4-pin, male) to type B (4-pin, male) USB cable. A USB 
cable measuring three meters or less is recommended.

2 Ethernet port 
(1000Base-T/100Base-
TX/10Base-T)

Use the LAN cable to connect this machine to the network. This ma-
chine supports the 1000Base-T, 100Base-TX and 10Base-T proto-
cols.
The TCP/IP (LPD/LPR, IPP), Web services and other protocols are 
supported.

1

2
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2 Printing in the Windows Environment

2.1 Preparation for printing (network connection)

2.1.1 Overview
Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that are supplied 
with this machine.

2.1.2 Before installing the printer driver (for administrators)

Connecting this machine to the network
 Checking a LAN cable for connection
 Checking the network settings

% Check that an IP address is assigned to this machine.

Configuring the network printing environment
 When using the Normal Printing (at Port 9100)

% Make sure that the RAW port number has been set. (Usually, you can use the default settings.) Use 
Normal Printing (Port 9100) unless otherwise specified.

 When using the Internet Printing (IPP)
% Check the IPP operating environment. (Usually, you can use the default settings.)

 When using the Secure Printing (IPPS)
% Set up the IPPS operating environment. Establish the communication with SSL encryption between 

this machine and the computer.

Preparation finished

Checking a LAN cable for connection
Check that a LAN cable is connected to the LAN port of this machine.

For details on the cable connection port, refer to page 1-4.

Checking the network settings
Print out the Configuration Page, then check that an IP address is assigned to this machine.

To print out the Configuration Page, select [Utility] - [User Settings] - [Printer Settings] - [Print Reports] - [Con-
figuration Page].

dReference
If no IP address is displayed, you need to set up the network. For details, refer to [Quick Start Guide].
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Configuring the network printing environment
Set up the operating environment to suit the printing method.

If the printing method is not specified before installation, Normal Printing (Port 9100) is selected for printing. 
Use Normal Printing (Port 9100) unless otherwise specified.

For details on how to configure settings, refer to Chapter 1 "Using Web Connection" in [User's Guide Applied 
Functions].

Tips
- If you are using Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, you cannot set up the 

Secure Printing (IPPS) using the installer.

- If you are using Windows XP or Server 2003 in an IPv6 environment, you cannot set up the Secure Print-
ing using the installer.

- Internet Printing (IPP) is not supported in the IPv6 environment.

Allowing device information to be acquired from the printer driver
Disable the OpenAPI authentication function. (Usually, you can use the default settings.)

When you allow acquisition of device information from the printer driver, the printer driver automatically ob-
tains information such as what options are installed on this machine and whether or not authentication set-
tings have been configured.

For details on how to configure settings, refer to Chapter 1 "Using Web Connection" in [User's Guide Applied 
Functions].

2.1.3 Easy installation of the printer driver

Preparing the printer driver
 Preparing the printer driver CD-ROM

% For the CD-ROM, contact the administrator of this machine.
 Checking the printer driver type

% Three printer drivers for different purposes are available. Select the printer driver that meets your 
printing objectives.

 Checking the operating systems supported by the printer driver
% Check that your computer meets the operating environment requirements of the printer driver.

Installing the printer driver to the computer
 Installing the printer driver using the installer

% Insert the printer driver CD-ROM into the drive, and install the software by following the on-screen 
instructions.

 Performing a test print
% If necessary, make a test print, then check that it is acceptable.

Preparation finished

Printing method Description

Normal Printing (Port 
9100)

Make sure that the RAW port number has been set. (Usually, you can use the 
default settings.)

Internet Printing (IPP) Check the IPP operating environment. (Usually, you can use the default set-
tings.)

Secure Printing (IPPS) Set up the IPPS operating environment. Establish the communication with SSL 
encryption between this machine and the computer.
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Preparing CD-ROM disks for the printer driver
The following CD-ROMs are supplied with this machine: The printer driver is included on the Drivers & Util-
ities CD-ROM.

Checking the printer driver type
The following types of printer drivers are available. Select the printer driver that meets your printing objec-
tives.

CD-ROM Description

Drivers & Utilities CD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS 
printer driver, Linux printer driver, and TWAIN driver. It also 
contains the download page of the utility software.

User's Guide CD-ROM Contains user's guides.

Printer driver Page description lan-
guage

Description

PCL driver PCL6 This is a standard driver for printing general office 
originals.
Among the three drivers, this driver provides the 
fastest printing speed.

PS driver PostScript 3 Emulation This driver is effective for high-definition printing of 
data created in PostScript-supporting application 
software from Adobe or other vendors.
This driver is often used in graphics and light print-
ing applications where good color reproducibility is 
important.

XPS driver XPS Developed after Windows Vista, this driver sup-
ports XML Paper Specification (XPS).
This driver has several advantages, including high-
quality reproduction of translucence.
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Checking the operating systems supported by the printer driver
The following lists the printer drivers included on the CD-ROMs supplied with this machine and the supported 
operating systems.

* Supports 32-bit (e86)/64-bit (e64) environment.

Printer driver Supported operating systems

PCL driver
PS driver

Windows XP Home Edition (Service Pack 3 or later) 
Windows XP Professional (Service Pack 3 or later)
Windows Server 2003, Standard Edition (Service Pack 2 or later)
Windows Server 2003, Enterprise Edition (Service Pack 2 or later)
Windows Server 2003 R2 Standard Edition
Windows Server 2003 R2 Enterprise Edition
Windows XP Professional e64 Edition (Service Pack 2 or later)
Windows Server 2003, Standard e64 Edition
Windows Server 2003, Enterprise e64 Edition
Windows Server 2003 R2, Standard e64 Edition
Windows Server 2003 R2, Enterprise e64 Edition
Windows Vista Business (Service Pack 2 or later)*
Windows Vista Enterprise (Service Pack 2 or later)*
Windows Vista Home Basic (Service Pack 2 or later)*
Windows Vista Home Premium (Service Pack 2 or later)*
Windows Vista Ultimate (Service Pack 2 or later)*
Windows Server 2008 Standard (Service Pack 2 or later)*
Windows Server 2008 Enterprise (Service Pack 2 or later)*
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium*
Windows 7 Professional*
Windows 7 Enterprise*
Windows 7 Ultimate*
Windows 8*

Windows 8 Pro*

Windows 8 Enterprise*

Windows Server 2012 Datacenter
Windows Server 2012 Standard

XPS driver Windows Vista Business (Service Pack 2 or later)*
Windows Vista Enterprise (Service Pack 2 or later)*
Windows Vista Home Basic (Service Pack 2 or later)*
Windows Vista Home Premium (Service Pack 2 or later)*
Windows Vista Ultimate (Service Pack 2 or later)*
Windows Server 2008 Standard (Service Pack 2 or later)*
Windows Server 2008 Enterprise (Service Pack 2 or later)*
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium*
Windows 7 Professional*
Windows 7 Enterprise*
Windows 7 Ultimate*
Windows 8*

Windows 8 Pro*

Windows 8 Enterprise*

Windows Server 2012 Datacenter
Windows Server 2012 Standard
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Installation procedure
Install the printer driver using the installer.

0 Administrator privileges are required to perform this task.

0 Use the Drivers & Utilities CD-ROM.

1 Insert the printer driver CD-ROM into the CD-ROM drive of the computer.

% Make sure that the installer starts, then proceed to Step 2.

% If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set-
up.exe], then go to Step 3.

% If the [User Account Control] window appears, click [Continue] or [Yes].

2 Click [Printer/FAX].

3 Read the license agreement, then click [AGREE].

4 Check the contents of the [Readme] window, then click [Next].

5 Select [Install printers/MFPs], then click [Next].

Connected printers are detected.

% For Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, you can select [Preference for 
IPv4] or [Preference for IPv6]. The address has the preference when detected in both IPv4 and IPv6.

6 Select this machine, then click [Next].

% If this machine is not detected, restart it.

% You do not need to change the printing method from [Normal Printing] (Port 9100) unless otherwise 
specified by the administrator.

% As the printing method, you can select [Normal Printing], [Internet Printing] (IPP), or [Secure Printing] 
(IPPS).

% Among the connected printers, only the target model is automatically detected and displayed. If 
multiple target models are displayed, check the IP addresses.

% If the connection to this machine cannot be recognized, it is not displayed in the list. In such a case, 
select [Specify the Printer/MFP Except for the Above. (IP Address, Host Name...)], then manually 
specify the IP address and host name of this machine.
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7 Select the check box of the printer driver you want to install, then click [Next].

% For features of each printer driver, refer to page 2-4.

8 Check the components to be installed, then click [Install].

9 If necessary, change the printer name or print a test page, then click [Finish].

Installation of the printer driver is then completed.

dReference
When you finish installing the printer driver, configure the default settings of the printer driver. For details, refer 
to page 2-8.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name, if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer to 
page 2-8.

[Print Setting] Changes the default print settings of this machine, if necessary. For details, re-
fer to page 2-8.

[Print Test page] If necessary, print a test page to check that printing process works correctly.
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2.1.4 Initializing the printer driver

Configuring the optional environment of this machine
When you use this machine for the first time, check that information such as what options are installed on 
this machine and whether or not authentication settings have been configured is correctly reflected to the 
printer driver.

1 Display the [Properties] window of the printer driver.

% For information on how to display the [Properties] window, refer to page 2-50.

2 In the [Configure] tab, check the information such as what options are installed on this machine and 
whether or not authentication settings have been configured.

% By default, [Auto] in [Acquire Settings...] is enabled. The information on this machine is automatically 
obtained and reflected to [Device Option].

% When [Auto] in [Acquire Settings...] is disabled, clicking [Acquire Device Information], obtains and 
reflects the information on this machine to [Device Option].

% If you cannot establish communication with this machine, manually set this information in [Device 
Option]. Select the item to change from the list, and set a value in [Setting].

3 Click [OK].

Change the default print settings
If necessary, you can change the default print settings of the printer driver.

1 Display the [Printing Preferences] window of the printer driver.

% For information on how to display the [Printing Preferences] window, refer to page 2-54.

2 Change the print settings, and click [OK].

The changed settings are applied when printing is performed from any application software.

dReference
The printer driver contains a function to save favorite settings. This is useful to register frequently used print 
settings as favorite settings. For details, refer to page 2-15.
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2.2 Preparation for printing (USB connection)

2.2.1 Overview
Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that are supplied 
with this machine.

2.2.2 Easy installation of the printer driver

Preparing the printer driver
 Preparing the printer driver CD-ROM

% For the CD-ROM, contact the administrator of this machine.
 Checking the printer driver type

% Three printer drivers for different purposes are available. Select the printer driver that meets your 
printing objectives.

 Checking the operating systems supported by the printer driver
% Check that your computer meets the operating environment requirements of the printer driver.

Installing the printer driver to the computer
 Configuring the installation settings on the computer

% If you are using Windows 7/8/Server 2008 R2/Server 2012, you need to change the computer set-
tings in advance.

 Installing the printer driver using the installer
% Connect the USB printer cable, insert the print driver CD-ROM into the drive, and install the software 

by following the on-screen instructions.
 Performing a test print

% If necessary, make a test print, then check that it is acceptable.

Preparation finished

Preparing the printer driver CD-ROM
The following CD-ROMs are supplied with this machine: The printer driver is included on the Drivers & Util-
ities CD-ROM.

Checking the printer driver type
The following types of printer drivers are available. Select the printer driver that meets your printing objec-
tives.

CD-ROM Description

Drivers & Utilities CD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS 
printer driver, Linux printer driver, and TWAIN driver. It also 
contains the download page of the utility software.

User's Guide CD-ROM Contains user's guides.

Printer driver Page description lan-
guage

Description

PCL driver PCL6 This is a standard driver for printing general office 
originals.
Among the three drivers, this driver provides the 
fastest printing speed.
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Checking the operating systems supported by the printer driver
The following lists the printer drivers included on the CD-ROMs supplied with this machine and the supported 
operating systems.

PS driver PostScript 3 Emulation This driver is effective for high-definition printing of 
data created in PostScript-supporting application 
software from Adobe or other vendors.
This driver is often used in graphics and light print-
ing applications where good color reproducibility is 
important.

XPS driver XPS Developed after Windows Vista, this driver sup-
ports XML Paper Specification (XPS).
This driver has several advantages, including high-
quality reproduction of translucence.

Printer driver Page description lan-
guage

Description

Printer driver Supported operating systems

PCL driver
PS driver

Windows XP Home Edition (Service Pack 3 or later) 
Windows XP Professional (Service Pack 3 or later)
Windows Server 2003, Standard Edition (Service Pack 2 or later)
Windows Server 2003, Enterprise Edition (Service Pack 2 or later)
Windows Server 2003 R2 Standard Edition
Windows Server 2003 R2 Enterprise Edition
Windows XP Professional e64 Edition (Service Pack 2 or later)
Windows Server 2003, Standard e64 Edition
Windows Server 2003, Enterprise e64 Edition
Windows Server 2003 R2, Standard e64 Edition
Windows Server 2003 R2, Enterprise e64 Edition
Windows Vista Business (Service Pack 2 or later)*
Windows Vista Enterprise (Service Pack 2 or later)*
Windows Vista Home Basic (Service Pack 2 or later)*
Windows Vista Home Premium (Service Pack 2 or later)*
Windows Vista Ultimate (Service Pack 2 or later)*
Windows Server 2008 Standard (Service Pack 2 or later)*
Windows Server 2008 Enterprise (Service Pack 2 or later)*
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium*
Windows 7 Professional*
Windows 7 Enterprise*
Windows 7 Ultimate*
Windows 8*

Windows 8 Pro*

Windows 8 Enterprise*

Windows Server 2012 Datacenter
Windows Server 2012 Standard

XPS driver Windows Vista Business (Service Pack 2 or later)*
Windows Vista Enterprise (Service Pack 2 or later)*
Windows Vista Home Basic (Service Pack 2 or later)*
Windows Vista Home Premium (Service Pack 2 or later)*
Windows Vista Ultimate (Service Pack 2 or later)*
Windows Server 2008 Standard (Service Pack 2 or later)*
Windows Server 2008 Enterprise (Service Pack 2 or later)*
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium*
Windows 7 Professional*
Windows 7 Enterprise*
Windows 7 Ultimate*
Windows 8*

Windows 8 Pro*

Windows 8 Enterprise*

Windows Server 2012 Datacenter
Windows Server 2012 Standard
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* Supports 32-bit (e86)/64-bit (e64) environment.

Changing the installation settings (Windows 7/8/Server 2008 R2/Server 2012)
If you are using Windows 7/8/Server 2008 R2/Server 2012, change the computer settings before installing 
the printer driver.

1 Open the [Control Panel] window.

% In Windows 8, right-click the Start window, then click [All apps] - [Control Panel].

% In Windows Server 2012, click [Control Panel] in the Start window.

% In Windows 7/Server 2008 R2, open the Start menu, then click [Control Panel].

2 Click [System and Security] - [System].

3 Click [Advanced system settings] on the menu in the left-hand pane.

The [System Properties] window appears.

4 In the [Hardware] tab, click [Device Installation Settings].

5 Select [No, let me choose what to do], select [Never install driver software from Windows Update.], then 
click [Save Changes].

% After you have installed the printer driver, change the setting back to [Yes, do this automatically (rec-
ommended) ].

6 Click [OK] to close the [System Properties] window.
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Installation procedure
Install the printer driver using the installer.

0 Administrator privileges are required to perform this task.

0 Use the Drivers & Utilities CD-ROM.

1 Connect a USB cable to the USB port of this machine.

% For details on the cable connection port, refer to page 1-4.

% If a wizard window for adding new hardware opens, click [Cancel].

2 Insert the printer driver CD-ROM into the CD-ROM drive of the computer.

% Make sure that the installer starts, then go to Step 3.

% If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set-
up.exe], then go to Step 4.

% If the [User Account Control] window appears, click [Continue] or [Yes].

3 Click [Printer/FAX].

4 Read the license agreement, then click [AGREE].

5 Check the contents of the [Readme] window, then click [Next].

6 Select [Install printers/MFPs], then click [Next].

USB-connected printers are detected.

7 Select this machine, then click [Next].

8 Select the check box of the printer driver you want to install, then click [Next].

% For features of each printer driver, refer to page 2-4.

9 Check the components to be installed, then click [Install].

10 If necessary, change the printer name or print a test page, then click [Finish].

Installation of the printer driver is then completed.
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dReference
When you finish installing the printer driver, configure the default settings of the printer driver. For details, refer 
to page 2-13.

2.2.3 Initializing the printer driver

Configuring the optional environment of this machine
When you use this machine for the first time, configure the printer driver so that it contains information such 
as what options are installed on this machine and whether or not authentication settings have been config-
ured.

1 Display the [Properties] window of the printer driver.

% For information on how to display the [Properties] window, refer to page 2-50.

2 In the [Configure] tab, configure the information such as what options are installed on this machine and 
whether or not authentication settings have been configured.

% If you are using Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, [Auto] under [Acquire 
Settings...] is enabled by default. Thus, the information of this machine is automatically obtained and 
applied for [Device Option].

% When [Auto] in [Acquire Settings...] is disabled, clicking [Acquire Device Information], obtains and 
reflects the information on this machine to [Device Option].

% If you are using Windows XP/Server 2003, set the option manually using [Device Option]. Select the 
item to change from the list, and set a value in [Setting].

3 Click [OK].

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name, if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer to 
page 2-8.

[Print Setting] Changes the default print settings of this machine, if necessary. For details, re-
fer to page 2-8.

[Print Test page] If necessary, print a test page to check that printing process works correctly.
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Change the default print settings
If necessary, you can change the default print settings of the printer driver.

1 Display the [Printing Preferences] window of the printer driver.

% For information on how to display the [Printing Preferences] window, refer to page 2-54.

2 Change the print settings, and click [OK].

The changed settings are applied when printing is performed from any application software.

dReference
The printer driver contains a function to save favorite settings. For details, refer to page 2-15.
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2.3 How to print

2.3.1 Printing operation flow

1 Open data of the original using the application software. From the [File] menu, select [Print].

2 In [Printer Name] (or [Select Printer]), make sure that the desired printer has been selected.

% The [Print] dialog box varies depending on the application software.

3 Specify the print range and the number of copies to print.

4 Click [Properties] (or [Preferences]) to change the print settings of the printer driver, if necessary.

% The print settings you have changed here return to the default values when you exit the application 
software. For information on how to change the default values of print settings, refer to page 2-8.

% The printer driver contains a function to easily recall frequently used print settings. For details, refer 
to page 2-15.

5 Click [Print].

Printing is executed.

2.3.2 Easily recalling frequently used print settings

Registering the frequently used setting
You can register the current print settings as a favorite and recall it when executing printing.

When you register a frequently used combination of print settings as a favorite, you can easily apply all of 
those settings just by selecting the combination from the Favorite Setting list, even if the combination is com-
plicated as it contains settings on multiple tabs.

The following explains the procedure of favorite print setting.

1 In the [Printing Preferences] window, set the print conditions you want to register as a favorite.
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2 Click [Add...].

% When you edit an existing setting, select its name from the [Favorite Setting], then click [Edit] In the 
Edit dialog box, you can select functions to be recalled with a favorite setting or import and export 
a favorite setting.

3 Enter names of the favorites to be registered.

% Set an icon, a comment and call options for the favorite settings, if necessary.

4 Click [OK].

The print settings are registered as a favorite. When starting printing, you can select the registered set-
ting from [Favorite Setting].

Settings Description

[Name] Enter names of the favorites to be registered.
Use names that can easily be identified.

[Icon] Assign an icon to the favorite settings, if necessary.

[Sharing] Select this check box to share the favorite settings with other users.

[Comment] Enter a comment to the favorite setting, if necessary.
The comment is displayed when you place the mouse cursor over the favorite 
in the Favorite Setting list.
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Customizing the setting window
You can gather setting items from difference tabs and place them in [My Tab].

Registering frequently used setting items in [My Tab] allows you to change settings in one tab, without switch-
ing among multiple tabs.

This section describes how to edit [My Tab].

1 Click [My Tab] - [Edit My Tab...].

% You can also register a function in [My Tab] by selecting [to the LEFT] or [to the RIGHT] from the [My 
Tab] menu that is displayed by right-clicking the function.

2 From [Setting Item List], select the function you want to register in [My Tab], then click [to the LEFT] or 
[to the RIGHT].

% Clicking [to the LEFT] places the selected function in the area to the left of [My Tab] and clicking [to 
the RIGHT] places it in the area to the right of [My Tab].

% An icon appears to the left of each function that is registered in [My Tab].

3 If necessary, move or delete the registered functions.

% To move a function, select the function and click [Up], [Down], or [Left/Right].

% To delete a function from [My Tab], select the function and click [Remove].

4 Click [OK].

Editing [My Tab] is then completed.
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2.4 Useful printing functions

2.4.1 Changing the paper size or type

Enlarging or reducing to the paper size ([Paper Size])
To make prints, enlarge or reduce the original with the zoom ratio that is automatically determined from the 
original size and paper size.

If you select a paper size larger than the original size, the original is enlarged to the paper size. If you select 
a paper size smaller than the original size, the original is reduced to the paper size.

In [Paper Size] of the [Basic] tab, select the size of paper for printing. The zoom ratio is automatically deter-
mined by the paper sizes selected in [Original Size] and [Paper Size].

Tips
This function is enabled when [Zoom] is set to [Auto].

Enlarging or reducing by the desired zoom ratio ([Zoom])
You can print the original image after it has been enlarged or reduced by the desired zoom ratio. The zoom 
ratio can be specified between 25% and 400% (in increments of 1%).

In [Zoom] of the [Basic] tab, specify the zoom ratio.
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Printing on paper of a special size ([Original Size])
A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.

1 In [Original Size] of the [Basic] tab, select [Custom Size].

% In [Paper Size], select [Same as Original Size].

2 Specify the width and length as desired, then click [OK].

dReference
Load the custom sized paper in the Manual Feed Tray. For details on how to load paper into the Manual 
Feed Tray, refer to Chapter 6 "Loading Paper" in [User's Guide Introduction].

When you are using the PCL driver, you can pre-register a custom size in the [Settings] tab. For details in the 
[Settings] tab, refer to page 2-53.

Specifying the paper type ([Paper Type])
In [Paper Type] of the [Basic] tab, select the type of paper for printing.

Specifying the paper tray ([Paper Tray])
In [Paper Tray] of the [Basic] tab, select the paper tray for printing.
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Tips
If you select [Auto], the paper tray for the paper you have selected in [Paper Size] is automatically selected.

Printing on postcards
Print the original on the postcard loaded in the Manual Feed Tray or Tray 1.

1 Set as follows on the [Basic] tab.

% [Original Size]: Select [Postcard].

% [Paper Size]: Select [Same as Original Size].

% [Paper Tray]: Select [Manual Feed] or [Tray 1].

2 Execute printing.

% For information on how to load postcards, refer to Chapter 6 "Loading Paper" in [User's Guide In-
troduction].

2.4.2 Printing multiple sets of copies

Specifying the number of copies ([Copies])
In [Copies] of the [Basic] tab, specify the number of copies you want to print.

dReference
When you print a large number of copies, use of the Proof then Print function will prevent a large number of 
misprints being created, reducing the amount of waste paper generated. For details, refer to page 2-40.
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Printing on a set basis ([Collate])
When the [Collate] check box on the [Basic] tab is selected, copies are output separately in a set-by-set man-
ner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4, and 5", and then "Pages 1, 2, 3, 4, and 5".

2.4.3 Saving the number of printed sheets

Printing multiple pages on the same side of a single sheet ([Combination])
You can print multiple reduced size pages on the same side of a single sheet to reduce the number of pages 
to be printed.

In [Combination] of the [Layout] tab, select "N in 1". For example, when you select [9 in 1], the size of every 
set of nine pages is reduced and printed on the same side of one sheet.

If necessary, click [Combination Details...] to set the page layout order and whether or not to input border 
lines between pages.

Settings Description

[Layout Order] Select the page layout order.
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Copying on both sides of paper ([2-Sided])
By using both sides of paper for printing, you can halve paper consumption.

In [Print Type] of the [Layout] tab, select [2-Sided].

Skipping blank pages ([Skip Blank Pages])
Skip blank pages contained in the original when printing the original. You can reduce the number of printed 
sheets.

In the [Layout] tab, select the [Skip Blank Pages] check box.

Tips
- For some originals, blank pages are also printed.

- This function is only available for the Windows printer driver (PCL/XPS).

[Border] Select this check box to draw border lines between pages. In addition, select 
the type of border lines from [Frame] and [Line].

Settings Description
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Printing on the back side of printed sheet ([Manually Print on 2nd Side])
In the [Basic] tab, select the [Manually Print on 2nd Side] check box.

Tips
When specifying [Manually Print on 2nd Side] for printing, use the back side of the sheet printed on this ma-
chine. The printing result with this setting is excluded from assurance.

2.4.4 Adjusting the layout

Printing in a booklet format ([Booklet])
Sort pages of the original in booklet format to perform 2-sided printing in two-page spread. When the printed 
sheets are collectively folded in two, they are arranged in the page order like a book.

In [Print Type] of the [Layout] tab, select [Booklet].

If necessary, click [Booklet Details...], then specify the binding position and whether or not to insert a border 
line between pages.
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Adding a margin on pages ([Binding Margin])
You can add a binding margin to each page to bind the printed sheets.

1 In the [Layout] tab, select the [Binding Margin] check box.

% In [Binding Position] of the [Layout] tab, specify the margin position.

2 Click [Binding Margin Settings...].

3 Adjust the size of margin, then click [OK].

Tips
This function is available only for the Windows printer driver.

Settings Description

[Binding Direction] Select the binding position in booklet format.

[Border] Select this check box to draw border lines between pages.

Settings Description

[Shift Mode] Select how the images are shifted for creating the margin.

[Front Side]/[Back Side] Specify the size of the margin on the front side.
When you print on both sides, specify the size of the margin on the back side. 
When the [Same value for front and back sides] check box is selected, a mar-
gin of the same size is created on both the front and back sides.
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Printing a poster-sized image ([Combination])
Enlarge an original image and divide it into multiple sheets to make prints. When you join the printed sheets 
together, a large poster is created.

In [Combination] of the [Layout] tab, select "N e N". For example, when you select [2 e 2], one page of the 
original image is enlarged, divided, and printed on four sheets.

If necessary, click [Combination Details...] to select whether or not to create overlap margins.

Tips
This function is available only for the PCL driver.

Rotating the image 180 degrees ([Rotate 180])
Print an image upside down. This function is available when printing on envelopes of which the loading di-
rection cannot be changed.

In the [Layout] tab, select the [Rotate 180] check box.
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Fine-tuning the print position ([Image Shift])
Fine-tune the print position of an image upward, downward, rightward, and leftward with respect to the pa-
per. When performing 2-sided printing, you can also fine-tune the print position of an image on the back side.

This function is available when a fine adjustment is required to slightly adjust the print position or change the 
print position between the front and back sides.

1 In the [Layout] tab, select the [Image Shift] check box.

2 Click [Image Shift Settings...].

3 Adjust the upward/downward and rightward/leftward shift distances, and click [OK]. 

Tips
This function is available only for the PCL driver.
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2.4.5 Adding a text or image to the original

Adding a water mark ([Watermark])
Print a text such as "NO REPRODUCTION" and "INTERNAL USE" on the center of all pages in a tint color.

By printing a watermark, you can specify the handling policy of copied originals.

In the [Stamp/Composition] tab, select the [Watermark] check box. In addition, select the watermark you 
want to print.

Tips
This function is available only for the Windows printer driver.

Registering or editing a watermark
This machine has several factory-set watermarks. However, you can register new watermarks or edit existing 
watermarks, if necessary.

1 In the [Stamp/Composition] tab, select the [Watermark] check box, and click [Edit].
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2 Click [Add] and register the watermark data.

% To edit a registered watermark, select the watermark from the [Current Watermark] list, and edit the 
data.

% To delete a registered watermark, select the watermark from the [Current Watermark] list, and click 
[Delete].

3 Click [OK].

Settings Description

[Watermark Name] Enter the name to be displayed in the watermark list (using up to 30 charac-
ters).

[Watermark Text] Enter the text to be displayed as a watermark (using up to 30 characters).

[Up]/[Down] Click these buttons to reorder items in the list. You can move frequently used 
watermarks to upper positions.

[Position] Specify the print position for the watermark.
• [X]/[Y]: Adjust the horizontal and vertical positions of the watermark. The 

values change as you move the slide bar.
• [Center]: Click this button to reset the watermark position to the center.
• [Angle]: Adjust the angle of the watermark.

[Font Name] Select the font for the watermark.

[Size] Specify the font size for the watermark.

[Style] Select the font style for the watermark.

[Frame] Select the frame for the watermark.

[Text Color] Select the color of the watermark.

[Transparent] Select this check box to print the watermark in a translucent tone.
When this check box is cleared, the printed watermark obscures the back-
ground.

[1st Page Only] Select this check box to print the watermark only on the first page of the orig-
inal.

[Repeat] Select this check box to repeatedly print the watermark on each page.

[Sharing] Select this check box to share the watermark with other users.
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Composing an overlay image ([Print in Overlay])
You can recall an overlay image registered on the computer to print it on the original as a composite image. 
For details on how to register an overlay image on your computer, refer to page 2-30.

In the [Stamp/Composition] tab, select the [Print in Overlay] check box, then select the overlay image to be 
composed on the original from the list.

If necessary, click [Edit...] to add or delete overlay images. Alternatively, change the method of composing 
an overlay image.

When using the PCL/XPS driver:

When using the PS driver:

Tips
- This function is available only for the Windows printer driver.

- When the PS driver is used, you need to download a target overlay image to this machine in advance.

Settings Description

[Select Overlay File] Add or delete an overlay image.

[Browse Files...] Add an overlay image to the list.

[Delete] Delete the selected overlay image from the list.

[File Information] Displays information on the selected overlay image.

[Overlay Print Setting] Change the method to compose an overlay image, if necessary.

[Pages] Select the range of pages to compose an overlay image on.

[Overwrite] Select whether or not to overwrite an overlay image on the front side of the 
original or to compose an overlay image on the back side of the original.

Settings Description

[Select Overlay File] Add or delete an overlay image.

[Manage Form 
File...]

Manage an overlay image.

[Delete] Delete the selected overlay image from the list.

[Download Manag-
er...]

Download an overlay image to the printer.
This option is available when the Download Manager is installed on this ma-
chine.

[Overlay Print Setting] Change the method to compose an overlay image, if necessary.

[Pages] Select the range of pages to compose an overlay image on.
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Creating an overlay image on the computer
In the [Stamp/Composition] tab, select the [Create Overlay File] check box, then print data to be registered 
as an overlay image to create an overlay file on the computer.

1 Create an original to be registered in an overlay image using application software.

2 In the [Stamp/Composition] tab, select the [Create Overlay File] check box.

3 In the application software, execute printing.

The [Create Overlay File] window appears.

4 Enter the file name to save the file.

The overlay file is saved on the computer. The saved overlay file is displayed on the [Stamp/Composi-
tion] tab, and it can be used for overlay printing.

Tips
This function is only available for the Windows printer driver (PCL/XPS).

2.4.6 Deterring unauthorized copying

Printing a concealed security watermark ([Copy Protect])
Print a text such as "Copy" or "INTERNAL USE" in the background pattern as concealed text. This function 
is called the Copy Protect function.

When a copy-protected original is copied, the concealed security watermark appears on the entire page, 
thereby indicating that it is an unauthorized copy.

In the [Stamp/Composition] tab, select the [Copy Protect] check box.

If necessary, click [Edit...] to specify the text to be printed and the format of the text. For details, refer to 
page 2-31.
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Tips
This function is available only for the Windows printer driver (PCL).

Configuring the print settings for Copy Protect
When printing a copy protect pattern on sheets, you can set the text to be printed and the format of the text, 
if necessary.

In the [Stamp/Composition] tab, select the [Copy Protect] check box, then click [Edit...].

2.4.7 Inserting paper into the original

Inserting a front or back cover ([Front Cover] / [Back Cover])
Insert a cover sheet different from text sheets into the head and end of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front cover, and 
collectively print the front cover with text pages.

1 In [Paper Tray] of the [Basic] tab, select the paper tray for printing text pages.

2 In the [Cover Mode] tab, select the [Front Cover] or [Back Cover] check box.

% If necessary, you can select whether or not to print the original on the inserted sheets or to leave 
them blank. When the PS driver is used, you cannot print an original on the inserted sheets.

% In [Front Cover Tray] or [Back Cover Tray], select the paper tray for the paper to be used as the front 
cover or the back cover.

Settings Description

[Pattern] Select whether or not the text pattern is to be embossed or outlined when the 
original is subjected to unauthorized copying.

[Pattern Overwrite] Select whether or not to compose a copy protect pattern on the front or back 
side of the original.

[Background Pattern] Select the copy protect pattern from the background patterns registered on 
this machine.

[Text/Background 
Color]

Select the color of the copy protect pattern.

[Characters] Select the text to be printed.
Selecting [Custom] can specify any text.

[Font Name] Select the font of the text to be printed.

[Text Size] Select the size of the text to be printed.
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Inserting a separator page ([Separator Page])
You can insert a sheet that is different from text sheets as a separator page on a job or copy basis.

1 In [Paper Tray] of the [Basic] tab, select the paper tray for printing text pages.

2 In the [Cover Mode] tab, select the [Separator Page] check box, then specify the position to insert a 
separator page.

% In [Separator Page Tray], select a paper tray to load sheets to be used as separator pages.

2.4.8 Specifying the color and image quality

Selecting printing colors ([Select Color])
In [Select Color] of the [Quality] tab, select printing colors from Auto Color or Gray Scale.
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Specifying the printing resolution ([Resolution])
In [Resolution] of the [Quality] tab, select the printing resolution.

Tips
This function is available only for the PCL/PS driver.

Fine-tuning the image quality according to the original ([Quality Adjustment])
You can fine-tune the color image quality according to the original. For example, you can increase the vivid-
ness or reduce the color difference.

1 In the [Quality] tab, click [Quality Adjustment].

2 Adjust the brightness and contrast to fit the original.

% When the PS/XPS driver is used, you can adjust only the brightness.

3 Click [OK].
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Tips
This function is available only for the Windows printer driver.

Selecting the optimum color representation for the original ([Color Settings])
You can select the optimum settings for an original such as photos or presentation materials to print it at the 
optimum image quality level.

In [Color Settings] of the [Quality] tab, select the optimum color setting mode to fit the original.

If necessary, you can specify the color representation method for each object (image, text, or graphics) in an 
original in detail.

1 In [Color Settings], select [Custom], then click [Details...].

2 Specify RGB colors and output profile for printing on an image, text, or graphics category basis.

3 Click [OK].

Tips
When you are using the PS driver, the following functions are available in the window shown in Step 2.

- [Download Manager...]: Starts Download Manager to download a profile, font data, or overlay file to 
this machine.

- [Manage Profile...]: Adds or deletes profiles.

Settings Description

[Image]
[Text]
[Graphics]

Configure a color setting for each image, text, or graphics category.
• [RGB Source]: Specify the color space of the input RGB for the printer.
• [RGB Intent]: Specify the property of color conversion from the input RGB 

to DeviceCMYK that is processed by the printer.
• [RGB Gray Treatment]: Specify the method to make prints in black or gray 

for the printer.
• [Destination Profile]: Specify the output profile for the printer (PS/XPS only).
• [Halftone]: Specify the screen property for the printer.
• [Edge Enhancement]: Specify whether or not to enhance the edge part.

[Simulation] (PS only) Configure the simulation settings.
• [Simulation Profile]: Select the simulation profile of the input CMYK for this 

machine.
• [Match Paper Color]: Select whether or not to suit the background of paper 

for printing when carrying out a simulation.
• [CMYK Gray Treatment]: Specify the printing method of plate K in the 

CMYK input data for simulation.
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Specifying the density of a graphic pattern ([Pattern])
In [Pattern] of the [Quality] tab, select the density of a graphic pattern.

Tips
This function is only available for the Windows printer driver (PCL/XPS).

Specifying the compression ratio of a graphic image ([Image Compression])
In [Image Compression] in the [Quality] tab, select whether or not the quality or printing speed is preferred 
when the image data contained in the original is compressed.

Tips
- This function is available only for the Windows printer driver (PCL).

- This function can be specified when [Auto Color] is selected in [Select Color].
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Making the image glossy ([Glossy Mode])
Images are printed with a glossy finish.

In the [Quality] tab, select the [Glossy Mode] check box.

Saving the toner consumption ([Toner Save])
Selecting the [Toner Save] check box in the [Quality] tab adjusts the printing density in order to reduce the 
amount of toner consumed.

Sharpening the border between texts ([Edge Strength])
Sharpen the edges of images such as text in the table and graphics to improve legibility.

In the [Quality] tab, select the [Edge Strength] check box, then select the emphasis level.
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Specifying the font processing method ([Font Settings])
Specify how the fonts are processed for printing.

1 In the [Quality] tab, click [Font Settings].

2 Change how the fonts are processed for printing. 

3 Click [OK].

Tips
- If characters are garbled in an environment where the PCL driver is used, we recommend that you se-

lect [Bitmap] in [Download Font Format] and clear the [Use Printer Fonts] check box.

- This function is available only for the Windows printer driver (PCL/PS).

Settings Description

[Download Font For-
mat]

Select a type of font to be downloaded from the computer to this machine.

[Use Printer Fonts] Select this check box to replace TrueType fonts with printer fonts during print-
ing. Use of printer fonts increases the printing speed.
In normal printing operations, we recommend that you select this check box.

[TrueType Font Substi-
tution Table] (PCL only)

Set this table when you want to specify the printer fonts that replace TrueType 
fonts.
From the list, select the TrueType font, then in [Printer Font to Use], select the 
printer font with which you want to replace the TrueType font.
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2.4.9 Printing Microsoft Excel/PowerPoint data

Printing multiple Excel sheets at one time
When multiple Microsoft Excel sheets with different print settings are printed at one time, this function pre-
vents the sheets from being printed separately.

In the [Other] tab, check the [Excel Job Control] box.

Tips
This function is only available for the Windows printer driver. However, this function may not be available de-
pending on a specific environment or application software.

Composing and printing an image correctly in PowerPoint
The process executed when an overlay image is printed on a PowerPoint original where a white background 
is optimized. This function prevents the overlay image from being overwritten by the white background of the 
PowerPoint original.

In the [Other] tab, select the [Remove White Background] check box.

Tips
This function is only available for the Windows printer driver (PCL/XPS). However, this function may not be 
available depending on a specific environment or application software.
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Preventing failure in printing thin lines ([Thin Line Support])
You can prevent thin lines from disappearing in reduced-size printing.

In the [Other] tab, select the [Thin Line Support] check box.

Tips
- This is effective for thin lines such as table borders created in Excel, but not for thin lines used in illus-

trations.

- This function is only available for the Windows printer driver (PCL).
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2.5 Printing options

2.5.1 Making a trial printing for only one copy ([Proof then Print])

Proof then Print
Proof then Print is a function that makes prints by only one copy and holds the remaining copies when print-
ing multiple copies.

Because you can check the print result before starting to print the remaining copies from the Control Panel, 
this function is useful for preventing printing of a large number of misprints.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Proof then Print].

2 Specify the number of copies, then execute printing.

Only one copy is printed. Continue to "Operations on this machine".

Operations on this machine

1 Tap [Document Print/Delete].
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2 Tap [Documents to Print].

3 Select the desired user, then tap [Open].

4 Select a job to print, then tap [Print].

% To delete a job, tap [Delete].

5 If necessary, change the number of copies, then tap [OK].

2.5.2 Printing highly confidential documents ([Secured Job])

Secured Job
Secured Job is a function that saves print data with a password on the HDD of this machine. Because the 
data is not printed straight away, this function prevents printed materials from going missing or being left un-
attended.

To print data from the HDD, you need to enter the password; this function is particularly suitable for safely 
printing highly confidential documents.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Secured Job].
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2 Enter the password, then click [OK].

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".

Operations on this machine
To print the saved data, you need to enter the password specified in the printer driver.

1 Tap [Document Print/Delete].

2 Tap [Documents to Print].

3 Select the desired user, then tap [Open].

4 Select a job to print, then tap [Print].

% To delete a job, tap [Delete].

5 Enter the password specified when printing data from the computer.

6 If necessary, change the number of copies, then tap [OK].
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2.5.3 Saving an original on the HDD of this machine ([Store Job] / [Print and Hold])

Store Job
Store Job is a function that saves print data on the HDD of this machine. Using the Print and Hold function, 
you can print data while simultaneously saving it on the HDD.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Store Job].

% To print data while simultaneously saving it on the HDD, select [Print and Hold].

2 Execute printing.

Print data is saved on the HDD of this machine.

Using the saved data

1 Tap [Document Print/Delete].
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2 Tap [Documents to Print].

3 Select the desired user, then tap [Open].

4 Select a job to print, then tap [Print].

% To delete a job, tap [Delete].

5 If necessary, change the number of copies, then tap [OK].

2.5.4 Attaching authentication information

Printing when authentication is set
When printing a document in an environment where user authentication or account track is employed, you 
need to send the authentication information (user name and password) to this machine to execute printing. 
This requirement limits the users who can use this machine, preventing unauthorized use by a third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that does not 
contain authentication information, this machine automatically discards the job.

Tips
- A print job that does not contain authentication information is a print job that is sent without correctly 

configuring the User Authentication/Account Track setting using the printer driver even though the User 
Authentication/Account Track setting is configured on this machine. 
The status in which the User Authentication/Account Track setting is not configured correctly means 
that the [Auto] check box of [Acquire Settings...] is cleared and [User Authentication]/[Account Track] 
of [Device Option] is set to [None] in the [Configure] tab of the [Properties] windows of the printer driver. 
In this status, if you select [Print] in [Job Retention] of the [Basic] tab at the time of printing to execute 
a print job, it is handled as a print job that does not contain authentication information.

- If [ID & Print] is set to [Enable] on [Security] - [ID & Print Settings] of Web Connection, an ordinary print 
job is handled as an ID & Print job (default: [Disable]). For details on the ID & Print function, refer to 
page 2-46.

dReference
When printing a highly confidential document in an environment where user authentication or account track 
is employed, using the ID & Print function enables high security printing. For details, refer to page 2-46.
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Operations required to use this function
In the [Configure] tab of the printer driver, check that the User Authentication/Account Track setting is cor-
rectly configured.

1 Display the [Properties] window of the printer driver.

% For information on how to display the [Properties] window, refer to page 2-50.

2 In [Device Option] of the [Configure] tab, check that the User Authentication/Account Track setting is 
correctly configured for your operating environment.

% If it is not configured correctly, select [User Authentication] or [Account Track] from the list, then 
change the relevant setting in [Setting].

3 Click [OK].

How to print from the computer

1 In the [Basic] tab, click [Authentication/Account Track...]
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2 When user authentication is enabled, select [Recipient User], then enter the user name and password.

% If access to this machine by public users (unregistered users) is allowed, you can select [Public User] 
and print data without entering the user name and password.

% When an external authentication server is used, click [Server Setting...] and select the authentication 
server.

3 If account track is enabled, enter the account name and password.

4 Click [OK].

% If a communication with this machine is established, you can click [Verify] to check the entered au-
thentication information. Also, you can check the authentication information for errors before print-
ing it.

5 Execute printing.

Printing starts successfully when the authentication information is judged correct.

2.5.5 Printing at the same time as authentication (ID & Print)

ID & Print
ID & Print is a function that saves print data to the HDD of this machine when user authentication is employed. 
Because the data is not printed straight away, this function prevents printed materials from going missing or 
being left unattended.

To print data from the HDD, you need to perform user authentication on this machine; this function is par-
ticularly suitable for safely printing highly confidential documents. When you are successfully authenticated, 
the print data of the login user is automatically printed. This enhances security as well as ensures smooth 
operation.

dReference
User Authentication/Account Track can only be configured using Web Connection. For details, refer to Chap-
ter 1 "Using Web Connection" in [User's Guide Applied Functions].

To enable the ID & Print function, select [Security] - [ID & Print Settings] in the Web Connection administrator 
mode, then set [ID & Print] to [Enable]. For details, refer to Chapter 1 "Using Web Connection" in [User's Guide 
Applied Functions].
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How to print from the computer

1 In [Job Retention], select [ID & Print].

2 In [Authentication/Account Track...] of the [Basic] tab, enter authentication information, then click [OK].

% For details, refer to page 2-44.

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".

Operations on this machine (Printing simultaneously with login)
You can print all data saved by the ID & Print function simultaneously when performing authentication on this 
machine.

1 Enter the user name and password.

2 Check that [ID & Print] is selected in [ID & Print/MFP Access], then tap [Login].

% When an optional Authentication Unit is used, you can switch [Device Authentication] and [Authen-
tication Unit] in [Authentication Method].

If authentication succeeds, all the saved data is printed.

% After data has been printed, do not log in to the machine.

% To change the default settings of [ID & Print] (default: [ID & Print/MFP Access]), select [Security] - 
[ID & Print Settings] - [Default Operation Selection] in the Web Connection administrator mode.
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Operations on this machine (Printing only specific data)
You can log in to this machine and specify data to be printed if you like to print only specific data.

1 Enter the user name and password.

2 In [ID & Print], select [Access Basic Screen], then tap [Login].

3 Tap [Document Print/Delete].

4 Tap [ID & Print].
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5 Tap [Login User].

6 Select data to be printed, then tap [Print].

% To delete data, tap [Delete].

The printed data is deleted from the HDD.
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2.6 Printer driver setting items

2.6.1 [Properties] window of the printer driver

How to display the [Properties] window
The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Prefer-
ences] window. This section describes the [Properties] window.

In the [Properties] window, you can configure settings for the optional environment of this machine or Win-
dows functions. To display the [Properties] window, take the following steps:

1 Display the printer window.

% In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and 
Sound] - [View devices and printers].

% In Windows Server 2012, open the Start window, then click [Control Panel] - [Hardware] - [View de-
vices and printers].

% In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers]. 
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], and click 
[View devices and printers].
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% In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and 
Sound] - [Printers]. 
When [Control Panel] is displayed in Classic View, double-click [Printers].

% In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes]. 
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] - 
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].
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2 Open the printer properties.

% In Windows 7/8/Server 2008 R2/Server 2012, right-click the icon of the installed printer, and from 
[Printer properties], click the displayed printer name.

% In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then click 
[Properties].

The [Properties] window appears.

Tabs provided by Windows
The [General], [Sharing], [Port], [Advanced], [Color Management], and [Security] tabs are provided by Win-
dows.

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to the Win-
dows manuals.



2.6 Printer driver setting items 2

[Print Functions] 2-53

2.6.2 Available operations in the [Configure] tab
You can specify which optional devices are installed on this machine using the [Configure] tab. You can au-
tomatically obtain information of this machine to manually configure settings.

Tips
- When [Auto] in [Acquire Settings...] is enabled and the computer is unable to communicate with this 

machine, the computer takes a long time to display the [Properties] window or the [Printing Preferences] 
window.

- If you are using the machine from a Windows XP/Server 2003 computer via USB connection, [Acquire 
Device Information] cannot be used.

2.6.3 Available operations in the [Settings] tab
In the [Settings] tab, you can change the default settings for how confirmation messages are displayed as 
well as the window for inputting authentication information.

Tips
- [EMF Spool] is a function of the PCL driver.

- [Save Custom Size...] is a function of the PCL driver.

Settings Description

[Device Option] The model name, options installed on this machine, and authentication set-
tings of this machine are displayed.
When the settings of this machine cannot be obtained, you need to manually 
change the settings. Select the item to change from the list, and set a value in 
[Setting].

[Acquire Device Infor-
mation]

Obtains information about which optional devices are installed on this machine 
by communicating with this machine.
In [Acquire Settings...], set the method of obtaining the information on this ma-
chine.

[Acquire Settings...] Configure the settings to obtain the information of this machine.

[Auto] Select this check box to automatically obtain the information of this machine.

[Destination Set-
tings]

Set the communication method to get information from this machine.
• [Device which Connect with Printer Port]: Information is obtained from the 

printing port specified in the [Port] tab in the printer driver.
• [Specify IP Address or Printer Name]: Information is obtained by connect-

ing to a device with the entered IP address or printer name.

[Software Tools] You can start up the software tools such as Web Connection.

Settings Description

[EMF Spool] Select this check box when meta file (EMF) spooling is required in your own 
system environment.

[Display Constraint 
Message]

Select this check box to display a message indicating that you have selected 
printer driver functions that cannot be used together.

[Display paper set in 
Print Server Properties]

Select this check box when using the paper added in [Server Properties] in the 
printer window.

[Verify Authentication 
settings before printing]

Select this check box to enable the [Verify] button in the [User Authentica-
tion/Account Track] dialog box.

[Popup Authentication 
Dialog when printing]

Select this check box to display the [User Authentication/Account Track] dia-
log box for printing. This option reminds you to enter the user name and pass-
word.

[Save Custom Size...] If you print on odd size paper, specify the size to register the paper.
The registered paper size can be selected from [Original Size] in the [Basic] tab.
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- The procedure for opening [Server Properties] is as follows: 

If you are using Windows 7/8/Server 2008 R2/Server 2012, select a printer, then click [Print Server 
Properties] on the toolbar. 
If Windows Vista or Windows Server 2008 is running, place the cursor pointer in an empty area of the 
[Printers] window, then click the mouse right button. From the shortcut menu, select [Run as adminis-
trator] - [Server Properties]. 
If Windows XP or Windows Server 2003 is running, click the [File] menu and select [Server Properties].

2.6.4 [Printing Preferences] window of the printer driver

How to display the [Printing Preferences] window
The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Prefer-
ences] window. This section describes the [Printing Preferences] window.

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped to enable 
you to configure print functions unique to this machine. To display the [Printing Preferences] window, take 
the following steps:

1 Display the printer window.

% In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and 
Sound] - [View devices and printers].

% In Windows Server 2012, open the Start window, then click [Control Panel] - [Hardware] - [View de-
vices and printers].

% In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers]. 
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], and click 
[View devices and printers].
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% In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and 
Sound] - [Printers]. 
When [Control Panel] is displayed in Classic View, double-click [Printers].

% In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes]. 
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] - 
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].
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2 Open [Printing Preferences].

% In Windows 7/8/Server 2008 R2/Server 2012, right-click the icon of the installed printer, and from 
[Printing preferences], click the displayed printer name.

% In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, and click 
[Printing Preferences...].

The [Printing Preferences] window of the printer appears.

Tips
The print settings changed here are registered as default values. When you want to temporarily change set-
tings to print from application software, click [Properties] (or [Preferences]) in the [Print] window to open the 
[Printing Preferences] window.

Items common to each tab
The following explains the commonly used settings and buttons in each tab.

Settings Description

[Favorite Setting] You can register the current print settings as a favorite and recall it when exe-
cuting printing.
For details on the [Favorite Setting], refer to page 2-15.

View Selecting [Paper View] displays a sample page layout based on the current set-
tings for checking the output result image.
Selecting [Printer View] displays a printer figure showing the options, such as 
paper trays, installed in the machine.

[Printer Information] Click this button to start Web Connection and check the printer information. 
This button is enabled only when your computer can communicate with this 
machine.
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2.6.5 Available operations in [Advanced]
[Advanced] is a tab to configure detailed settings for PostScript. This function is only available for the PS driv-
er.

Tips
[Advanced Printing Features:] is displayed when the [Enable advanced printing features] check box is select-
ed in the [Advanced] tab of the [Properties] window.

2.6.6 Available operations in [My Tab]
[My Tab] allows you to customize the display contents.

You can gather setting items from difference tabs and place them in [My Tab]. Registering frequently used 
setting items in [My Tab] allows you to change settings in one tab, without switching among multiple tabs.

For details on how to edit [My Tab], refer to page 2-17.

2.6.7 Available operations in [Basic]
In the [Basic] tab, you can configure basic settings about paper or printing. Functions that are frequently used 
in normal printing are placed in this tab.

[OK] Applies the changes made to the settings and closes the setting window.

[Cancel] Discards (or cancels) the current changes and closes the setting window.

[Help] Displays the help for each item in the window.

[Default] Initializes the current settings.

Settings Description

Settings Description

[Advanced Printing 
Features:]

Select whether or not to enable the booklet print setting.

[PostScript Options] Configure the PostScript option setting.
• [PostScript Output Option]: Select the method to output a PostScript file.
• [Send PostScript Error Handler]: Select whether or not to print a report 

when a PostScript error has occurred.
• [Mirrored Output]: Select whether or not to print an image in mirror-re-

versed mode.

[PostScript Pass 
through]

Select whether or not to allow the application to print data directly without us-
ing the printer driver.

Settings Description

[More Details] Click this button to display the Help of [My Tab].

[Do not show again] Select this check box if you do not want to display the comment field contain-
ing [More Details].

[Edit My Tab...] Click this button to register or delete the functions displayed in [My Tab].

Settings Description

[Original Orientation] Specify the orientation of the original created in application software.
If the setting in the printer driver differs from the one specified in the application 
software, correct the setting.

[Original Size] Select the size of the original created in application software.
If the setting in the printer driver differs from the one specified in the application 
software, correct the setting.
To print on custom sized paper, select [Custom Size] and specify the width and 
length. For details, refer to page 2-19.
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[Paper Size] Select the size of paper for printing.
If the size of the paper is different from that of the original size, and if [Zoom] is 
set to [Auto], the original is sent by enlarging or reducing it according to the se-
lected paper size.
To print on custom sized paper, select [Custom Size] and specify the width and 
length. For details, refer to page 2-19.

[Zoom] Select how the print image is enlarged or reduced.
• [Auto]: The image is enlarged or reduced according to the size of the paper 

specified in [Paper Size].
• [Manual]: The image is enlarged or reduced by the specified ratio (25 to 

400%).

[Paper Tray] Select the paper tray for the printing paper.
When you select [Auto], the tray containing the paper selected in [Paper Size] is 
automatically used.

[Paper Type] When you have selected [No setting] in [Paper Tray], select the paper type for 
printing. Selecting [No setting] applies the paper type specified on [Utility] - [Us-
er Settings] - [Printer Settings] - [Paper Setting] - [Paper Tray] on the Control 
Panel.

[Job Retention] Select the method to use to print the original from this machine.

[Print] Select this option to print normally.

[Store Job] Select this option to save the original on the HDD of this machine.
For details, refer to page 2-43.

[Print and Hold] Select this option to save the original on the HDD of this machine and simulta-
neously execute a print job.
For details, refer to page 2-43.

[Secured Job] Select this option to print highly confidential documents. Printing is carried out 
when the password is entered on this machine.
For details, refer to page 2-41.

[Proof then Print] Select this option to print a large number of copies. This machine prints only one 
copy and waits for the user's command before printing the remaining copies.
For details, refer to page 2-40.

[ID & Print] Select this option to print highly confidential documents in an environment 
where user authentication is employed. Printing is allowed when the user is au-
thenticated to use this machine.
For details, refer to page 2-46.

[User Settings...] Enter the required information when [Secured Job] is selected in [Job Reten-
tion].

[Authentication/Ac-
count Track...]

When user authentication or account track is employed, enter the user name or 
account name and the password. For details, refer to page 2-44.

[Copies] When printing multiple sets of copies, specify the number of sets.

[Collate] When printing multiple sets of copies, select this check box to output sets of 
copies one by one.
When this check box is cleared, the first page of the original is printed on as 
many sheets as the number specified in [Copies], and then each of the subse-
quent pages is printed in this manner.

[Manually Print on 2nd 
Side]

Select this check box to print on the back side of a sheet that has been printed 
on once.
When specifying [Manually Print on 2nd Side] for printing, use the back side of 
the sheet printed on this machine. The printing result with this setting is exclud-
ed from assurance.

Settings Description
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2.6.8 Available operations in the [Layout] tab
In the [Layout] tab, you can configure layout settings for printing. You can combine pages or adjust print po-
sitions.

Settings Description

[Combination] Select how the original pages are combined on sheets.
• [2 in 1]/[4 in 1]/[6 in 1]/[9 in 1]/[16 in 1]: 

Multiple pages are reduced and printed on the same side of one sheet. For 
example, when you select [9 in 1], the size of every set of nine pages is re-
duced and printed on the same side of one sheet.

• [2 e 2]/[3 e 3]/[4 e 4] (PCL only): 
The original image is enlarged, divided and printed on multiple sheets. For 
example, when you select [2 e 2], one page of the original is divided and 
printed on four sheets. When you join the printed sheets together, a large 
poster is created.

If necessary, click [Combination Details...] to configure detailed settings about 
page combination.
• [Combination]: Select the page combination.
• [Layout Order]: When you have selected "N in 1" in [Combination], select 

the order of pages in the layout.
• [Border]: When you have selected "N in 1" in [Combination], select this 

check box if you want to draw border lines between pages. In addition, se-
lect the type of border lines.

• [Overlap width line]: When you have selected "N e N" in [Combination], se-
lect this check box if you want to create overlap margins.

[Rotate 180] Select this check box to rotate the original 180 degrees and print it.

[Skip Blank Pages] Select this check box to exclude blank pages in the original from the pages to 
be printed.

[Print Type] Select the print sides of paper.
• [1-Sided]: The original is printed on one side of a sheet of paper.
• [2-Sided]: The original is printed on both sides of a sheet of paper.
• [Booklet]: The original is printed in booklet format. Original pages are sort-

ed and printed on both sides of sheets in two-page spread mode. When 
the printed sheets are collectively folded in two, they are arranged in the 
page order like a book. If necessary, click [Booklet Details...], then specify 
the binding position and whether or not to draw border lines.

[Binding Position] Select the binding position.

[Binding Margin] Select this check box to provide a margin on printed sheets.
Click [Binding Margin Settings...] to specify the size of the margin in detail.
• [Shift Mode]: Select how the images are shifted for creating the margin.
• [Front Side]: Specify the size of the margin on the front side.
• [Back Side]: When you print on both sides, specify the size of the margin 

on the back side. When the [Same value for front and back sides] check 
box is selected, a margin of the same size is created on both the front and 
back sides.

[Image Shift] Select this check box to fine-tune (shift) the print position of the image with re-
spect to the paper.
Click [Image Shift Settings...] to specify the print position in detail.
• [Front Side]: Specify the upward/downward and rightward/leftward shift 

distances for the front side.
• [Back Side]: When you print on both sides, specify the upward/downward 

and rightward/leftward shift distances for the back side.
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2.6.9 Available operations in the [Cover Mode] tab
In the [Cover Mode] tab, you can insert covers and pages.

2.6.10 Available operations in the [Stamp/Composition] tab
In the [Stamp/Composition] tab, you can configure settings for adding text or an image to the original.

2.6.11 Available operations in the [Quality] tab
In the [Quality] tab, you can configure settings for the image quality of the original. You can specify colors, 
image processing, and font processing.

Items that can be specified vary depending on your printer driver.

Settings Description

[Front Cover] Select this check box to insert and print on a front cover. In [Front Cover Tray], 
select the paper tray for the front cover. Then, select whether or not to print on 
the inserted front cover.
• [Blank]: Nothing is printed on the inserted front cover.
• [Printed (1-Sided)]: Select this option to print on one side of the sheet that 

is inserted as a front cover.
• [Printed (2-Sided)]: Select this option to print on both sides of the sheet that 

is inserted as a front cover.
You can set this option when you have selected anything other than [Auto] in 
[Paper Tray] in the [Basic] tab.

[Back Cover] Select this check box to insert and print on a back cover. In [Back Cover Tray], 
select the paper tray for the back cover. Then, select whether or not to print on 
the inserted back cover.
• [Blank]: Nothing is printed on the inserted back cover.
• [Printed (1-Sided)]: Select this option to print on one side of the sheet that 

is inserted as a back cover.
• [Printed (2-Sided)]: Select this option to print on both sides of the sheet that 

is inserted as a back cover.
You can set this option when you have selected anything other than [Auto] in 
[Paper Tray] in the [Basic] tab.

[Separator Page] Select this check box when inserting a separator sheet for each job or copy to 
make prints. Then, select the position to insert a separator page from [Header 
(Each Job)], [Header (Each Copy)], and [Trailer (Each Copy)]. In [Separator 
Page Tray], select a paper tray to load sheets to be used as separator pages.
You can set this option when you have selected anything other than [Auto] in 
[Paper Tray] in the [Basic] tab.

Settings Description

[Watermark] Select this check box to print a watermark (text stamp) on the original. In addi-
tion, from the list, select the watermark you want to print.
Clicking [Edit...] allows you to register or edit a watermark. For details, refer to 
page 2-27.

[Copy Protect] (PCL 
only)

Select this check box to print a text such as "Copy" or "INTERNAL USE" in the 
background pattern as concealed text.
When you click [Edit...], you can configure detailed settings such as Copy Pro-
tect printing items or the printing method. For details, refer to page 2-30.

[Create Overlay File] 
(PCL/XPS)

Select this check box to save data created in application software on the com-
puter as an overlay image to be composed on the original. For details, refer to 
page 2-30.

[Print in Overlay] Select this check box to compose the created overlay image on the original 
when printing. For details, refer to page 2-29.

Settings Description

[Select Color] Select colors for printing.
• [Auto Color]: The color mode is automatically selected according to the 

original color.
• [Gray Scale]: The original is printed in black and white regardless of wheth-

er or not the original is in color or in black and white.
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2.6.12 Available operations in the [Other] tab
In the [Other] tab, you can check the driver version and configure print settings for application software.

Tips
- [Excel Job Control] and [Remove White Background] are not available depending on a specific environ-

ment or application software.

[Quality Adjustment...] Adjust the brightness and contrast to fit the original.

[Color Settings] Select the optimum color setting mode for the original.
• [Auto]: The color setting suitable for originals is applied automatically.
• [Photo]: The color setting that prioritizes the image quality is applied.
• [Presentation]: The color setting suitable for originals containing both text 

and figures is applied.
• [ICM] (PS only): The color setting is applied using the Windows ICM func-

tion. When you click [Details...], you can specify the ICM method and ob-
jectives.

• [Custom]: Manually configure the color setting for each object (image, text, 
or graphics) in the original. For details, refer to page 2-34.

• [Disable] (PCL/PS): Prints without performing color conversion.

[Resolution] (PCL/PS) Select the print resolution.

[Pattern] (PCL/XPS) Select the pattern density.

[Image Compression] 
(PCL only)

Select the compression mode for the image data contained in the original.
• [Best Quality]: The process prioritizes quality. Quality is improved, but 

printing takes a long time.
• [Maximum Compression]: The process prioritizes speed. The printing time 

is shortened, but the printing quality is deteriorated.

[Glossy Mode] Select this check box to print images with a glossy finish. The printing speed 
is reduced.

[Toner Save] Select this check box to save the amount of toner consumed. The printing den-
sity is reduced.

[Edge Strength] Select this check box to sharpen small or faint characters, then specify the 
strength level.

[Font Settings] 
(PCL/PS)

Specify how to process texts.
Select a type of font to be downloaded from the computer to this machine. 
Also specify whether or not replace the TrueType fonts by printer fonts when 
printing.
If characters are garbled in an environment where the PCL driver is used, we 
recommend that you select [Bitmap] in [Download Font Format] and clear the 
[Use Printer Fonts] check box.

Settings Description

Settings Description

[Excel Job Control] Select this check box to print multiple Microsoft Excel sheets with different 
page settings at one time.
When multiple sheets with different page settings are printed at one time, the 
sheets may be separated into single-sheet jobs depending on the data con-
tained. This function avoids job separation as much as possible.

[Remove White Back-
ground] (PCL/XPS)

Select this check box to superimpose an overlay image on Microsoft Power-
Point data.
White areas are removed so that the white background of the PowerPoint data 
does not hide the overlay image. Clear this check box to print the original as is 
without removing the background.

[Thin Line Support] 
(PCL only)

Select this check box to perform reduced-size printing. This function prevents 
thin lines from disappearing.
This is effective for thin lines such as table borders created in Excel, but not for 
thin lines used in illustrations.

[Check Driver Version] The version of the printer driver is displayed.
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- You can change the [Excel Job Control] setting only when the printer driver setting dialog box is dis-

played on the [Printers] ([Devices and Printers] in Windows 7/8/Server 2008 R2/Server 2012 and [Print-
ers and Faxes] in Windows XP/Server 2003) window.
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2.7 Uninstalling the printer driver

Using the deletion program
If the printer driver was installed using the installer, the uninstallation function for the printer driver is also in-
stalled.

0 Administrator privileges are required to perform this task.

1 Start the deletion program.

% From the Start menu, click [All Programs] (or [Programs]) - [KONICA MINOLTA] - model name of this 
machine - [Uninstall Printer Driver].

% In Windows 8, right-click the Start window, select [All apps] - [Control Panel] - [Programs], then click 
[Uninstall a program]. Double-click the driver to be uninstalled in the list.

% In Windows Server 2012, open the Start window, then click [Control Panel] - [Programs] - [Uninstall 
a program]. Double-click the driver to be uninstalled in the list.

2 Select the printer driver you want to uninstall, then click [Uninstall].

% Follow the subsequent on-screen instructions.

3 If the dialog box prompting to restart the computer appears, click [OK].

Uninstallation of the printer driver is then completed.

Uninstall using the installer
If you have installed the driver using the installer, you can use the installer to uninstall the driver.

0 Administrator privileges are required to perform this task.

1 Insert the printer driver CD-ROM into the CD-ROM drive of the computer.

% Make sure that the installer starts, then proceed to Step 2.

% If the installer does not start, open the printer driver folder on the CD-ROM, double-click [Set-
up.exe], then go to Step 3.

2 Click [Printer/FAX].

The printer driver installer starts.

3 Click [AGREE] in the license agreement window.

4 Check the contents of the [Readme] window, then click [Next].

5 Select [Uninstall Printer Driver], then click [Next].

6 Select the printer driver you want to uninstall, then click [Uninstall].

% Follow the subsequent on-screen instructions.

7 If a dialog box prompting you to restart the computer appears, click [OK] to restart the computer.

Uninstallation of the printer driver is then completed.
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3 Printing in the Mac OS Environment

3.1 Preparation for printing (Bonjour connection)

3.1.1 Overview
Before using this machine as a printer, you need to install the printer driver on your computer and add the 
printer to your computer.

This section describes preparations required to carry out printing on this machine by Bonjour (Rendezvous) 
connection that is supported in Mac OS X 10.3 or later.

Tips
- The Bonjour technology enables you to configure the network settings for networked devices and find 

and use services without the need for configuring special settings.

- In Mac OS X 10.3, Bonjour is called Rendezvous.

3.1.2 Before setting up the computer (for administrators)

Connecting this machine to the network
 Checking a LAN cable for connection

Configuring the Bonjour settings
 Enabling Bonjour
 Setting a printer name (Bonjour name)

% Enter the name of this machine to be displayed as the name of a connected device.

Preparation finished

Checking a LAN cable for connection
Check that a LAN cable is connected to the LAN port of this machine.

For details on the cable connection port, refer to page 1-4.

Configuring the Bonjour settings
Enable Bonjour. (You can use this function with the default settings unless otherwise requested.) In addition, 
enter the name of this machine (Bonjour name) to be displayed as the name of a connected device.

For details on how to configure settings, refer to Chapter 1 "Using Web Connection" in [User's Guide Applied 
Functions].
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3.1.3 Setting up the computer

Preparing the printer driver
 Preparing the printer driver CD-ROM

% For the CD-ROM, contact the administrator of this machine.
 Checking the operating systems supported by the printer driver

% Check that your computer meets the operating environment requirements of the printer driver.

Installing the printer driver to the computer
 Installing the printer driver using the installer

% Mount the Drivers & Utilities CD-ROM disk on the drive, and install the software by following the 
on-screen instructions.

 Adding the printer
% Add the printer automatically detected by Bonjour to the computer.

Preparation finished

Preparing the printer driver CD-ROM
The following CD-ROMs are supplied with this machine: The printer driver is included on the Drivers & Util-
ities CD-ROM.

Checking the operating systems supported by the printer driver
The following lists the printer drivers included on the CD-ROMs supplied with this machine and the supported 
operating systems.

CD-ROM Description

Drivers & Utilities CD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS 
printer driver, Linux printer driver, and TWAIN driver. It also 
contains the download page of the utility software.

User's Guide CD-ROM Contains user's guides.

Printer driver Page description language Supported operating systems

PostScript PPD driver (PS-
PPD)

PostScript 3 Emulation Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x, 
10.7.x, 10.8.x)
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Installing the printer driver
Install the printer driver using the installer.

0 Before installation, exit all application software programs that are running.

1 Mount the Drivers & Utilities CD-ROM disk into the CD-ROM drive of the computer.

2 Open the folder on the CD-ROM that contains the desired printer driver.

% Select the folder according to the printer driver, operating system, and language to be used.

3 Copy the driver file onto the desktop according to the Mac OS X version.

% Mac OS X 10.3: model name of this machine_103104.pkg

% Mac OS X 10.4: model name of this machine_103104.pkg

% Mac OS X 10.5: model name of this machine_105.pkg

% Mac OS X 10.6: model name of this machine_106.pkg

% Mac OS X 10.7: model name of this machine_106.pkg

% Mac OS X 10.8: model name of this machine_106.pkg

% In Mac OS X 10.5 or later, the driver folder varies depending on the paper size. Select the appropri-
ate folder to suit your environment. 
To mainly use the metric-based paper size such as A4 size: "WW_A4" folder 
To mainly use the inch-based paper size such as letter size or 8 1/2 e 11: "WW_Letter" folder

4 Double-click the file copied onto the desktop.

The printer driver installer starts.

5 Click [Continue] following the instructions on the pages that follow until the [Install] page appears.

% When the name and password prompt appears during the procedure, enter the administrator name 
and password.

6 Click [Install].

The printer driver is installed on the computer.

7 Click [Close].

The installation process of the printer driver is then completed. Then, add the printer to the computer.

Configuring connection using Bonjour (Mac OS X 10.4 or later)
Add the printer automatically detected by Bonjour to the computer.

1 Select [System Preferences...] in the Apple menu.

2 Click the [Print & Fax] or [Print & Scan] icon.

3 Click [+] on the [Print & Fax] or [Print & Scan] window.

% In Mac OS X 10.4/10.5/10.6, go to Step 4.

% In Mac OS X 10.7/10.8, if a target printer name is found in the list displayed by clicking [+], select it. 
When a printer driver is selected automatically, the printer addition is completed. If a target printer 
name is not found, select [Add Other Printer or Scanner...] or [Add Printer or Scanner...], and go to 
Step 4.

4 Click [Default].

Connected printers are detected.

% If no printers are detected, restart this machine.
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5 From the [Printer Name] list, select the desired printer for a Bonjour connection.

% To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode of Web 
Connection.

% By default, ( ) at the end of the printer name corresponds to the last three bytes of the MAC address.

The printer driver for the selected printer is displayed in [Print Using:].

% When the printer driver is displayed, go to Step 7.

% When the printer driver is not correctly displayed, go to Step 6.

6 Manually select the printer driver.

% In Mac OS X 10.6 or later, select [Select Printer Software...] in [Print Using:], then click the driver of 
the desired printer from the list that is displayed in another window.

% In Mac OS X 10.5, select [Select a driver to use...] in [Print Using:], then click the driver of the desired 
printer from the list.

% In Mac OS X 10.4, select [KONICA MINOLTA] in [Print Using:], and then click the driver of the desired 
printer from the list.

7 Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window 
to configure the optional environment for this machine. For details, refer to page 3-6.

Configuring connection using Rendezvous (Mac OS X 10.3)
Add the printer automatically detected by Rendezvous to the PC.

1 From [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], double-click [Printer Setup 
Utility] or [Print Center] to open it.

2 When the [You have no printers available.] window appears, click [Add]. When the [Printer List] appears, 
click [Add].

% If available printers have already been specified, the [You have no printers available.] window does 
not appear.

3 Select [Rendezvous] as the connection method.

Connected printers are detected.

% If no printers are detected, restart this machine.
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4 From the [Name] list, select the desired printer for Rendezvous connection.

% To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode of Web 
Connection.

% By default, ( ) at the end of the printer name corresponds to the last three bytes of the MAC address.

5 Manually select the printer driver.

% In [Printer Model:], select [KONICA MINOLTA], then click the driver of the desired printer from the 
model list.

6 Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window 
to configure the optional environment for this machine. For details, refer to page 3-6.

3.1.4 Initializing the printer driver

Configuring the optional environment of this machine
When you use this machine for the first time, properly configure the printer driver so that it contains informa-
tion such as the options installed on this machine.
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1 Open the [Print & Fax] (or [Print & Scan]/[Printer Setup Utility]/[Print Center]) window.

% The [Print & Fax] or [Print & Scan] window can be opened from [System Preferences...] in the Apple 
menu (Mac OS X 10.4 or later).

% The [Printer Setup Utility]/[Print Center] window can be opened from [Macintosh HD] (hard disk of 
the system) - [Applications] - [Utilities].

2 Display the [Printer Information] window.

% For the [Print & Fax]/[Print & Scan] window, click [Options & Supplies...] (Mac OS X 10.5 or later) or 
[Printer Setup...] (Mac OS X 10.4).

% For the [Printer Setup Utility]/[Print Center] window, click [Show Info] of the [Printer] menu.

3 Display the [Installable Options] window.

% In Mac OS X 10.5 or later, click [Driver].

% In Mac OS X 10.3/10.4, select [Installable Options].

4 Change the settings according to the options installed on this machine.

5 Click [OK] or [Apply Changes] to close the [Printer Information] window.

Changing the default print settings
In the [Page Setup] window of the printer driver, you can change the default settings for paper and zoom ratio.

1 Display the [Page Setup] window of the printer driver.

% For information on how to display the [Page Setup] window, refer to page 3-31.

2 Change the settings, and select [Save As Default] from [Settings:].
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3.2 Preparation for printing (USB connection)

3.2.1 Overview
Before using this machine as a printer, you need to install the printer driver on your computer and add the 
printer to your computer.

This section describes preparations required to carry out printing on this machine by USB connection.

3.2.2 Setting up the computer

Preparing the printer driver
 Preparing the printer driver CD-ROM

% For the CD-ROM, contact the administrator of this machine.
 Checking the operating systems supported by the printer driver

% Check that your computer meets the operating environment requirements of the printer driver.

Installing the printer driver to the computer
 Installing the printer driver using the installer

% Mount the Drivers & Utilities CD-ROM disk on the drive, and install the software by following the 
on-screen instructions.

 Adding the printer
% Add the printer that is automatically detected by USB connection to the computer.

Preparation finished

Preparing the printer driver CD-ROM
The following CD-ROMs are supplied with this machine: The printer driver is included on the Drivers & Util-
ities CD-ROM.

Checking the operating systems supported by the printer driver
The following lists the printer drivers included on the CD-ROMs supplied with this machine and the supported 
operating systems.

CD-ROM Description

Drivers & Utilities CD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS 
printer driver, Linux printer driver, and TWAIN driver. It also 
contains the download page of the utility software.

User's Guide CD-ROM Contains user's guides.

Printer driver Page description language Supported operating systems

PostScript PPD driver (PS-
PPD)

PostScript 3 Emulation Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x, 
10.7.x, 10.8.x)
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Installing the printer driver
Install the printer driver using the installer.

0 Before installation, exit all application software programs that are running.

1 Mount the Drivers & Utilities CD-ROM disk into the CD-ROM drive of the computer.

2 Open the folder on the CD-ROM that contains the desired printer driver.

% Select the folder according to the printer driver, operating system, and language to be used.

3 Copy the driver file onto the desktop according to the Mac OS X version.

% Mac OS X 10.3: model name of this machine_103104.pkg

% Mac OS X 10.4: model name of this machine_103104.pkg

% Mac OS X 10.5: model name of this machine_105.pkg

% Mac OS X 10.6: model name of this machine_106.pkg

% Mac OS X 10.7: model name of this machine_106.pkg

% Mac OS X 10.8: model name of this machine_106.pkg

% In Mac OS X 10.5 or later, the driver folder varies depending on the paper size. Select the appropri-
ate folder to suit your environment. 
To mainly use the metric-based paper size such as A4 size: "WW_A4" folder 
To mainly use the inch-based paper size such as letter size or 8 1/2 e 11: "WW_Letter" folder

4 Double-click the file copied onto the desktop.

The printer driver installer starts.

5 Click [Continue] following the instructions on the pages that follow until the [Install] page appears.

% When the name and password prompt appears during the procedure, enter the administrator name 
and password.

6 Click [Install].

The printer driver is installed on the computer.

7 Click [Close].

The installation process of the printer driver is then completed. Then, add the printer to the computer.

Configuring USB connection settings (Mac OS X 10.5 or later)
Add the printer that is automatically detected by USB connection to the computer.

1 Connect a USB cable to the USB port of this machine.

% For details on the cable connection port, refer to page 1-4.

2 Select [System Preferences...] in the Apple menu.

3 Click the [Print & Fax] or [Print & Scan] icon.

4 Click [+] on the [Print & Fax] or [Print & Scan] window.

% In Mac OS X 10.4/10.5/10.6, go to Step 4.

% In Mac OS X 10.7/10.8, if a target printer name is found in the list displayed by clicking [+], select it. 
When a printer driver is selected automatically, the printer addition is completed. If a target printer 
name is not found, select [Add Other Printer or Scanner...] or [Add Printer or Scanner...], and go to 
Step 4.

5 Click [Default].

Connected printers are detected.
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% If no printer is detected, check that this machine is turned on and the USB cable is connected, then 
restart the computer.

6 From the [Printer Name] list, select the desired printer that　is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

7 Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window 
to configure the optional environment for this machine. For details, refer to page 3-6.

Configuring USB connection settings (Mac OS X 10.4)

1 Connect a USB cable to the USB port of this machine.

% For details on the cable connection port, refer to page 1-4.

2 Select [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], then double-click [Printer 
Setup Utility] to open the dialog box.

3 In the [Printer List] window, click [Add].

Connected printers are detected.

% If no printer is detected, check that this machine is turned on and the USB cable is connected, then 
restart the computer.

4 From the list, select the desired printer that is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

5 Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window 
to configure the optional environment for this machine. For details, refer to page 3-6.

Configuring USB connection settings (Mac OS X 10.3)

1 Connect a USB cable to the USB port of this machine.

% For details on the cable connection port, refer to page 1-4.

2 Select [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], then double-click [Printer 
Setup Utility] to open the dialog box.

3 In the [Printer List] window, click [Add].

4 Select [USB] as the connection method.

Connected printers are detected.
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% If no printer is detected, check that this machine is turned on and the USB cable is connected, then 

restart the computer.

5 From the list, select the desired printer that is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

6 Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window 
to configure the optional environment for this machine. For details, refer to page 3-6.

3.2.3 Initializing the printer driver

Configuring the optional environment of this machine
When you use this machine for the first time, properly configure the printer driver so that it contains informa-
tion such as the options installed on this machine.

1 Open the [Print & Fax] (or [Print & Scan]/[Printer Setup Utility]/[Print Center]) window.

% The [Print & Fax] or [Print & Scan] window can be opened from [System Preferences...] in the Apple 
menu (Mac OS X 10.4 or later).

% The [Printer Setup Utility]/[Print Center] window can be opened from [Macintosh HD] (hard disk of 
the system) - [Applications] - [Utilities].

2 Display the [Printer Information] window.

% For the [Print & Fax]/[Print & Scan] window, click [Options & Supplies...] (Mac OS X 10.5 or later) or 
[Printer Setup...] (Mac OS X 10.4).

% For the [Printer Setup Utility]/[Print Center] window, click [Show Info] of the [Printer] menu.

3 Display the [Installable Options] window.

% In Mac OS X 10.5 or later, click [Driver].

% In Mac OS X 10.3/10.4, select [Installable Options].

4 Change the settings according to the options installed on this machine.

5 Click [OK] or [Apply Changes] to close the [Printer Information] window.
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Change the default print settings
In the [Page Setup] window of the printer driver, you can change the default settings for paper and zoom ratio.

1 Display the [Page Setup] window of the printer driver.

% For information on how to display the [Page Setup] window, refer to page 3-31.

2 Change the settings, and select [Save As Default] from [Settings:].
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3.3 How to print

3.3.1 Printing operation flow

1 Open data of the original using the application software. From the [File] menu, select [Print].

2 Check that the desired printer is selected in [Printer:].

% The [Print] dialog box varies depending on the application software.

3 Specify the print range and the number of copies to print.

% In Mac OS X 10.7/10.8, if the setting items (1) are not displayed, click [Show Details].

% In Mac OS X 10.5/10.6, if the setting items (1) are not displayed, click on the right side of [Printer:].

4 If necessary, switch the menu of application names (2) and change the print settings.

% The print settings you have changed here return to the default values when you exit the application 
software. This is useful to register frequently used print settings as presets. For details, refer to 
page 3-14.

5 Click [Print].

Printing is executed.

1

2
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3.3.2 Registering frequently used print settings
You can register the current print settings as a preset and recall it when executing printing.

When you register a frequently used combination of print settings as a preset, you can easily apply all of those 
settings just by selecting the combination from the presets, even if the combination is complicated as it con-
tains settings on multiple menus.

1 Display the [Print] window of the printer driver.

% For information on how to display the [Print] window, refer to page 3-31.

2 Change the print settings, and select [Save As...] or [Current Print Settings as Preset] from [Presets:].

3 Enter the name of the print setting.

The saved setting can be recalled from [Presets:]. Use a name that helps you easily identify the preset.
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3.4 Useful printing functions

3.4.1 Changing the paper size or type

Enlarging or reducing by the desired zoom ratio ([Scale:])
You can print the original image after it has been enlarged or reduced by the desired zoom ratio.

In [Scale:] of [Page Attributes], specify the zoom ratio.

Printing on custom size paper ([Page Setup])
A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.

In [Page Attributes] under [Paper Size:], select [Manage Custom Sizes...], and specify the desired width and 
length.

1 From the [File] menu, click [Page Setup] (or [Paper Setup]).

% In Mac OS X 10.5 or later, you can configure the same setting in [Paper Size:] in the [Print] window.

2 Open the window for registering a custom size.

% In Mac OS X 10.4 or later, select [Manage Custom Sizes...] from the Paper Size list.

% In Mac OS X 10.3, select [Custom Paper Size] from [Settings:].

3 Click [+] (Mac OS X 10.4 or later) or [Add] (Mac OS X 10.3).

4 Enter the name of the paper size you are registering.

% Be sure to use paper size names other than existing names, such as A4 and Custom.

5 Specify the width and length as desired.

% If necessary, set the top, bottom, right, and left margins of the paper in [Non-Printable Area:] or 
[Printer Margins:].

6 Click [OK] (Mac OS X 10.4 or later) or [Save] (Mac OS X 10.3).

This saves the custom paper size, which can be selected from the [Paper Size:] drop-down list in [Page 
Attributes].

dReference
To print on custom sized paper, use Manual Feed Tray. For details on how to load paper into the Manual 
Feed Tray, refer to Chapter 6 "Loading Paper" in [User's Guide Introduction].
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Specifying the paper type ([Paper Type:])
In [Paper Type:] of the [Basic] menu for [Printer Features], select the paper type for printing.

Specifying the paper tray ([Paper Feed])
In [All Pages From:] of [Paper Feed], select the paper tray for printing.

Enlarging or reducing to the nearest page size ([Nearest Size and Scale])
If the size of sheets loaded in the paper tray does not match that of the original data, the page size is auto-
matically enlarged or reduced to be printed on sheets of the next nearest size.

Select [Printer Features] - [Basic], then select the [Nearest Size and Scale] check box.

3.4.2 Printing multiple sets of copies

Specifying the number of copies ([Copies:])
In [Copies:] of the [Print] window, specify the number of copies you want to print.

Tips
In Mac OS X 10.3/10.4, specify the number of copies in [Copies & Pages].

dReference
When you print a large number of copies, use of the Proof then Print function will prevent a large number of 
misprints being created, reducing the amount of waste paper generated. For details, refer to page 3-24.
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Printing on a set basis ([Collate])
When the [Collate] check box is selected on the [Basic] menu of [Printer Features], copies are output sepa-
rately in a set-by-set manner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4, and 5", and then "Pages 
1, 2, 3, 4, and 5".

3.4.3 Saving the number of printed sheets

Copying on both sides of paper ([2-Sided])
By using both sides of paper for printing, you can halve paper consumption.

In [Print Type:] of the [Layout] menu for [Printer Features], select [2-Sided]. Also, in [Binding Position:], select 
the binding position.

Printing multiple pages on the same side of a single sheet 
([Pages per Sheet:])
You can print multiple reduced size pages on the same side of a single sheet to reduce the number of pages 
to be printed.

In [Pages per Sheet:] of [Layout], specify how many pages are to be printed on the same side of one sheet. 
For example, when you select [9], every set of nine pages is reduced and printed on the same side of one 
sheet.

If necessary, specify the paging order in [Layout Direction:], then select whether or not to insert a border line 
between pages in [Border:].
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Printing on the back side of printed sheet ([Manually Print on 2nd Side])
Select [Printer Features] - [Basic], then select the [Manually Print on 2nd Side] check box.

Tips
When specifying [Manually Print on 2nd Side] for printing, use the back side of the sheet printed on this ma-
chine. The printing result with this setting is excluded from assurance.

3.4.4 Adjusting the layout

Reversing the left and right sides ([Flip horizontally])
Reverse the left and right sides of a print image to make prints.

In [Layout], select the [Flip horizontally] check box.

Tips
This function is available only for Mac OS X 10.6/10.7/10.8.

Rotating a print image 180 degrees ([Reverse page orientation])
Print an image upside down. This function is available when printing on envelopes of which the loading di-
rection cannot be changed.

In [Layout], select the [Reverse page orientation] check box.
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Tips
This function is available only for Mac OS X 10.5/10.6/10.7/10.8.

3.4.5 Inserting a front cover

Inserting a front cover ([Paper Feed])
Insert a cover sheet that is different from text sheets into the head of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front cover, and 
collectively print the front cover with text pages.

In [First Page From:] of [Paper Feed], select the paper tray to load a sheet to be used as a front cover. Also, 
in [Remaining From:], select the paper tray to load text sheets.

Printing a message on a cover page ([Cover Page])
Print a message such as [Confidential] or [Secret] on a cover page.

In [Print Cover Page:] of [Cover Page], select whether or not to print a cover page at the head or end of the 
document, then specify the type of the message to be printed in [Cover Page Type:].

To print billing information, enter the information to be printed in [Billing Info:].

3.4.6 Specifying the color and image quality

Printing with gray scale ([Color as Grayscale])
In [Color Options], select the [Color as Grayscale] check box.
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Fine-tuning the brightness to fit the original ([Brightness:])
In [Brightness:] of [Color Options], fine-tune the brightness to fit the original.

Specifying the printing resolution ([Resolution:])
In [Resolution:] of the [Basic] menu for [Printer Features], select the printing resolution.

Selecting the optimum color representation for the original 
([Color Settings:])
Select the optimum settings for an original such as photos or presentation materials to print it at the optimum 
image quality level.

In [Color Settings:] of [Color Options], select the optimum color setting mode for the original.

If necessary, you can specify the color representation method for each object (image, text, or graphics) in an 
original in detail.

1 In [Color Settings:] of [Color Options], select [Custom], then click [Advanced Color Options].
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2 Specify RGB colors and output profile for printing on an image, text, or graphics category basis.

dReference
In [Manage Profile], you can add or delete various profiles. For details, refer to page 3-22.

Making the image glossy ([Glossy Mode])
Images are printed with a glossy finish.

In [Color Options], select the [Glossy Mode] check box.

Saving the toner consumption ([Toner Save])
Selecting the [Toner Save] check box in [Color Options] adjusts the printing density in order to reduce the 
amount of toner consumed.

Settings Description

[Image]
[Text]
[Graphics]

Configure a color setting for each image, text, or graphics category.
• [RGB Source:]: Specify the color space of the input RGB for the printer.
• [RGB Intent:]: Specify the property of color conversion from the input RGB 

to Device CMYK that is processed by the printer.
• [RGB Gray Treatment:]: Specify the method to make prints in black or gray 

for the printer.
• [Destination Profile:]: Specify the output profile for the printer.
• [Halftone:]: Specify the screen property for the printer.
• [Edge Enhancement:]: Specify whether or not to enhance the edge part.

[Simulation] Configure the simulation settings.
• [Simulation Profile]: Select the simulation profile of the input CMYK for this 

machine.
• [Match Paper Color:]: Select whether or not to suit the background of paper 

for printing when carrying out a simulation.
• [CMYK Gray Treatment:]: Specify the printing method of plate K in the 

CMYK input data for simulation.
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Increasing the legibility of small or faint text ([Edge Strength:])
Sharpen the edges of images such as text in the table and graphics to improve legibility.

In [Edge Strength:] of [Color Options], select the strength level.

3.4.7 Using a color profile

Registering a color profile on this machine
Save a color profile on the HDD of this machine using Download Manager.

0 Before starting this procedure, newly create a "Download Manager (model name)" folder in the appli-
cation folder of the computer, then copy the Download Manager program to the created folder. The 
Download Manager program can be downloaded from the utility software download page that is dis-
played by selecting [PageScope Utilities] in the Drivers & Utilities CD-ROM menu.

0 For details on how to use Download Manager, refer to the Download Manager Help.

1 Start Download Manager.

2 Select [Color Profile], then specify this machine in [Choose Printer:].

3 Select [Download], then select [Disk] as a download destination.

4 Click [Browse], then specify the color profile you want to download to the HDD of this machine.

% Set the color profile name to the format "file name = ASCII (up to eight characters) + extension ASCII 
(up to three characters)".

5 Click [Download Profile].

6 Click [OK].

7 Click [Exit].

Adding a color profile to the printer driver
Add the color profiles saved on the HDD of this machine to the printer driver.

0 This function is available if the computer can communicate with this machine. The computer commu-
nicates with this machine and loads color profiles that the machine can use.

0 For details on how to register a color profile on the HDD of this machine, refer to page 3-22.

1 In [Color Settings:] of [Color Options], select [Custom], then click [Advanced Color Options].
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2 Click [Manage Profile].

3 In Driver Profile List, select the type of the color profile to be added to the printer driver.

4 Select the color profile to be added, then click [Add].

5 Click [OK].

The color profile is added to Driver Profile List.

After this, you can specify the color profile added here on the [Advanced Color Options] window to carry 
out printing. For details, refer to page 3-20.
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3.5 Printing options

3.5.1 Making a trial printing for only one copy ([Proof then Print])

Proof then Print
Proof then Print is a function that makes prints by only one copy and holds the remaining copies when print-
ing multiple copies.

Because you can check the print result before starting to print the remaining copies from the Control Panel, 
this function is useful for preventing printing of a large number of misprints.

How to print from the computer

1 In [Job Retention:] of the [Security] window, select [Proof then Print].

2 Specify the number of copies, then execute printing.

Only one copy is printed. Continue to "Operations on this machine".

Operations on this machine

1 Tap [Document Print/Delete].
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2 Tap [Documents to Print].

3 Select the desired user, then tap [Open].

4 Select a job to print, then tap [Print].

% To delete a job, tap [Delete].

5 If necessary, change the number of copies, then tap [OK].

3.5.2 Printing a highly confidential original ([Secured Job])

Secured Job
Secured Job is a function that saves print data with a password on the HDD of this machine. Because the 
data is not printed straight away, this function prevents printed materials from going missing or being left un-
attended.

To print data from the HDD, you need to enter the password; this function is particularly suitable for safely 
printing highly confidential documents.

How to print from the computer

1 In [Job Retention:] of the [Security] window, select [Secured Job].

2 Enter the password.

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".
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Operations on this machine
To print the saved data, you need to enter the password specified in the printer driver.

1 Tap [Document Print/Delete].

2 Tap [Documents to Print].

3 Select the desired user, then tap [Open].

4 Select a job to print, then tap [Print].

% To delete a job, tap [Delete].

5 Enter the password specified when printing data from the computer.

6 If necessary, change the number of copies, then tap [OK].

3.5.3 Attaching authentication information

Printing when authentication is set
When printing a document in an environment where user authentication or account track is employed, you 
need to send the authentication information (user name and password) to this machine to execute printing. 
This requirement limits the users who can use this machine, preventing unauthorized use by a third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that does not 
contain authentication information, this machine automatically discards the job.

Tips
- A print job that does not contain authentication information is a print job that is sent without correctly 

configuring the User Authentication/Account Track setting using the printer driver even though the User 
Authentication/Account Track setting is configured on this machine. 
If [Print] in [Job Retention:] is selected to execute a print job while the [User Authentication]/[Account 
Track] check box is cleared in the [Security] window of the printer driver, the print job is considered as 
a print job that does not contain authentication information.
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- If [ID & Print] is set to [Enable] on [Security] - [ID & Print Settings] of Web Connection, an ordinary print 

job is handled as an ID & Print job (default: [Disable]). For details on the ID & Print function, refer to 
page 3-27.

dReference
When printing a highly confidential document in an environment where user authentication or account track 
is employed, using the ID & Print function enables high security printing. For details, refer to page 3-27.

How to print from the computer

1 In the [Security] window, select the [User Authentication] check box (and the [Account Track] check 
box).

2 When user authentication is enabled, select the [User Authentication] check box, select [Recipient Us-
er], then enter the user name and password.

% If access to this machine by public users (unregistered users) is allowed, you can select [Public User] 
and print data without entering the user name and password.

3 When account track is enabled, select the [Account Track] check box, enter the account name and 
password, then click [OK].

4 Execute printing.

Printing starts successfully when the authentication information is judged correct.

3.5.4 Printing at the same time as authentication ([ID & Print])

ID & Print
ID & Print is a function that saves print data to the HDD of this machine when user authentication is installed. 
Because the data is not printed straight away, this function prevents printed materials from going missing or 
being left unattended.

To print data from the HDD, you need to perform user authentication on this machine; this function is par-
ticularly suitable for safely printing highly confidential documents. When you are successfully authenticated, 
the print data of the login user is automatically printed. This enhances security as well as ensures smooth 
operation.

dReference
User Authentication/Account Track can only be configured using Web Connection. For details, refer to Chap-
ter 1 "Using Web Connection" in [User's Guide Applied Functions].

To enable the ID & Print function, select [Security] - [ID & Print Settings] in the Web Connection administrator 
mode, then set [ID & Print] to [Enable]. For details, refer to Chapter 1 "Using Web Connection" in [User's Guide 
Applied Functions].
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How to print from the computer

1 In [Job Retention:], select [ID & Print].

2 Select the [User Authentication], select [Recipient User], then enter the user name and password.

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".

Operations on this machine (Printing simultaneously with login)
Print all data saved by the ID & Print function simultaneously when performing authentication on this machine.

1 Enter the user name and password.

2 Check that [ID & Print/MFP Access] is selected in [ID & Print], then tap [Login].

% When an optional Authentication Unit is used, you can switch [Device Authentication] and [Authen-
tication Unit] in [Authentication Method].

If authentication succeeds, all the saved data is printed.

% After data has been printed, do not log in to the machine.

% To change the default settings of [ID & Print] (default: [ID & Print/MFP Access]), select [Security] - 
[ID & Print Settings] - [Default Operation Selection] in the Web Connection administrator mode.



[Print Functions] 3-29

3.5 Printing options 3

Operations on this machine (Printing only specific data)
To print only specific data, log in to this machine, then specify data to be printed.

1 Enter the user name and password.

2 In [ID & Print], select [Access Basic Screen], then tap [Login].

3 Tap [Document Print/Delete].

4 Tap [ID & Print].
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5 Tap [Login User].

6 Select data to be printed, then tap [Print].

% To delete data, tap [Delete].

The printed data is deleted from the HDD.
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3.6 Printer driver setting items

3.6.1 [Page Setup] window of the printer driver

How to display the [Page Setup] window

1 Open the original data using the application software. From the [File] menu, click [Page Setup] (or [Pa-
per Setup]).

2 Check that the desired printer is selected in [Format for:].

The [Page Attributes] window appears.

Available operations in [Page Attributes]
In [Page Attributes], you can configure basic paper settings.

Tips
In Mac OS X 10.5 or later, you can also specify [Print] and [Orientation] in the [Paper Size] window.

3.6.2 [Print] window of the printer driver

How to display the [Print] window

1 Open data of the original using the application software. From the [File] menu, select [Print].

Settings Description

[Paper Size:] Select the size of paper for printing.
To print on custom sized paper, use [Manage Custom Sizes...]. For details, re-
fer to page 3-15.

[Orientation:] Specify the orientation of the original created in application software.
If the setting in the printer driver differs from the one specified in the application 
software, correct the setting.

[Scale:] Specify the zoom ratio to enlarge or reduce the original image. The setting 
range differs depending on the Mac OS X version.
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2 Check that the desired printer is selected in [Printer:].

Items common to each window
This section describes the settings and buttons common to the [Print] window.

Tips
- [Copies:], [Pages:], [Paper Size:], and [Orientation:] are displayed in Mac OS X 10.5 or later.

- In Mac OS X 10.7/10.8, [Collated] is not displayed.

- In Mac OS X 10.3/10.4, [Copies:] and [Pages:] can be specified in [Copies & Pages].

3.6.3 Available operations in [Layout]
In [Layout], you can configure layout settings for printing.

Settings Description

[Copies:] When printing multiple sets of copies, specify the number of sets.

[Collated] Do not specify this function.
In the [Basic] menu of [Printer Features], select the [Collate] checkbox.

[Pages:] When printing a multi-page original, specify the range of pages to be printed.

[Paper Size:] Specify the size of the paper to be printed.

[Orientation:] Specify the printing orientation.

[Cancel] Discards (or cancels) the current changes and closes the setting window.

[Print] Applies the changes made to the settings and starts printing.

Settings Description

[Pages per Sheet:] Select how many pages are to be printed on the same side of one sheet.
For example, when you select [9], every set of nine pages is reduced and print-
ed on the same side of one sheet.

[Layout Direction:] Select the paging order when [Pages per Sheet:] is specified.

[Border:] Select whether or not to insert a border line between pages when [Pages per 
Sheet:] is specified. If you want to insert a border line between pages, select 
the border line type.

[Two-Sided] Do not specify this function.
In [Print Type:] of the [Layout] menu for [Printer Features], select this function.

[Reverse page orienta-
tion]

Select this check box to rotate a print image 180 degrees.

[Flip horizontally] Select this check box to reverse the left and right sides of a print image.



[Print Functions] 3-33

3.6 Printer driver setting items 3

3.6.4 Available operations in [Scheduler]
In [Scheduler] you can specify the print starting timing or priority sequence.

Tips
This function is available only for Mac OS X 10.3/10.4/10.5/10.6.

3.6.5 Available operations in [Paper Handling]
In [Paper Handling], you can specify pages to be printed or their order.

Tips
[Collated] is displayed only in Mac OS X 10.7/10.8.

3.6.6 Available operations in [ColorSync]
In [ColorSync], you can specify the color conversion method or Quartz filter.

Tips
This function is available only for Mac OS X 10.3/10.4.

Settings Description

[Print Document:] Specify the timing to start printing.
• [Now]: Starts printing immediately.
• [At]: Starts printing at the specified time.
• [On Hold]: Holds print jobs in the computer. Printing can be started from 

the job screen of the printer.

[Priority:] Specify the priority level of each print job.

Settings Description

[Collated] Do not specify this function.
In the [Basic] menu of [Printer Features], specify the value in [Collate].

[Pages To Print:] Specify the pages to be printed from All, Odd, and Even.

[Page Order:] Specify the order of pages to be printed.
• [Automatic]: Automatically judges the order of pages to be printed.
• [Normal]: Prints pages in sequence from the first.
• [Reverse]: Prints pages in sequence from the last.

[Destination Paper 
Size:]

Specify the size of the paper to be printed.
• [Scale to fit paper size]: Prints data on sheets of the specified size.
• [Scale down only]: Prints data only on sheets to be reduced.

Settings Description

[Color Conversion:] Select the color conversion method.
• [Standard]: Performs color conversion using the computer.
• [In Printer]: Performs color conversion using the printer.

[Quartz Filter:] Specify the Quartz filter to be applied.
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3.6.7 Available operations in [Color Matching]
In [Color Matching], you can specify the color conversion method or a color profile.

Tips
This function is available only for Mac OS X 10.5 or later.

3.6.8 Available operations in [Cover Page]
In [Cover Page], you can configure settings to print a cover page.

3.6.9 Available operations in [Error Handling]
In [Error Handling], you can specify processing when an error has occurred during PS printing.

Tips
This function is available only for Mac OS X 10.3/10.4.

3.6.10 Available operations in [Paper Feed]
In [Paper Feed], you can specify the paper tray for printing.

Settings Description

[ColorSync] / [In Printer] Select the color conversion method.
• [ColorSync]: Performs color conversion using the computer.
• [In Printer]: Performs color conversion using the printer.

[Profile:] Specify the color profile to be used for color conversion.

Settings Description

[Print Cover Page:] Select whether or not to print a cover page at the head or end of a document.

[Cover Page Type:] Select the type of a message to be printed on a cover page.

[Billing Info:] Enter billing information when printing it on a cover page.

Settings Description

[PostScript Errors] Select whether or not to output a report when an error has occurred during PS 
printing.

[Tray Switching] This function is not used in this printer driver.

Settings Description

[All Pages From:] Specify the paper tray for printing.

[First Page From:] Specify the paper tray to load sheets for printing the first page. Also, in [Re-
maining From:], specify the paper tray for printing the remaining pages.
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3.6.11 Available operations in [Color Options]
In [Color Options], you can configure settings for the image quality of the original. You can specify colors and 
image processing.

3.6.12 Available operations in [Security]
In [Security], you can configure print settings.

Settings Description

[Color Settings:] Select the optimum color setting mode for the original.
• [Auto]: The color setting suitable for originals is applied automatically.
• [Photo]: The color setting that prioritizes the image quality is applied.
• [Presentation]: The color setting suitable for originals containing both text 

and figures is applied.
• [Custom]: Manually configure the color setting for each object (image, text, 

or graphics) in the original. Selecting [Custom] enables [Advanced Color 
Options].

[Brightness:] Adjust the brightness to fit the original.

[Color as Grayscale] Select whether or not to print in color or gray scale.

[Glossy Mode] Select this check box to print images with a glossy finish.

[Toner Save] Select this check box to save the amount of toner consumed. The printing den-
sity is reduced.

[Edge Strength:] Select this check box to enhance image edges when you want to sharpen 
small or faint characters.

[Advanced Color Op-
tions]

For each element of the document, specify in detail the type of the color profile 
used for printing and other profiles to be applied. For details, refer to 
page 3-20.

Settings Description

[Job Retention:] Select the method to use to print the original from this machine.

[Print] Select this option to print normally.

[Secured Job] Select this option to print highly confidential documents. Printing is allowed 
when the ID and password are entered on this machine.
For details, refer to page 3-25.

[Proof then Print] Select this option to print a large number of copies. This machine prints only one 
copy and waits for the user's command before printing the remaining copies.
For details, refer to page 3-24.

[ID & Print] Select this option to print highly confidential documents in an environment 
where user authentication is employed. Printing is allowed when the user is au-
thenticated to use this machine.
For details, refer to page 3-27.

[Security Print Settings] Enter the password when [Secured Job] is selected in [Job Retention:].

[User Authentication] When user authentication is employed, select this check box, then enter the 
user name and password.

[Account Track] When account track is employed, select this check box, then enter the account 
name and password.
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3.6.13 Available operations in [Printer Features]
Configure the basic print settings on the [Basic] menu.

In the [Layout] menu, you can configure layout settings for printing.

3.6.14 Available operations in [Supply Levels]
In [Supply Levels], you can check the status of consumables.

Tips
- This function is displayed when a Bonjour connection, IPP connection, or LPD connection is estab-

lished in Mac OS X 10.4 or later.

- This function may not be displayed depending on your application software.

3.6.15 Available operations in [Summary]
In [Summary], you can check the current print settings.

Tips
This function is displayed only in Mac OS X 10.3/10.4/10.5/10.6.

Settings Description

[Collate] When printing multiple sets of copies, select this check box to output sets of 
copies one by one.

[Nearest Size and 
Scale]

Select whether or not to automatically enlarge or reduce the page size and 
print data on sheets of the next nearest size when the size of sheets loaded in 
the paper tray does not match that of the original data.

[Manually Print on 2nd 
Side]

Select whether or not to print data on the back side of a sheet that has been 
printed on once.
To apply this function, use the back side of the sheet that was printed on this 
machine. The printing result with this setting is excluded from assurance.

[Paper Type:] Select the type of sheets to be printed.

[Resolution:] Select the print resolution.

Settings Description

[Print Type:] Select whether or not to print data on both sides of paper.

[Binding Position:] When you have selected [2-Sided] in [Print Type:], select the binding position 
of paper.
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3.7 Uninstalling the printer driver
When you have to remove the printer driver, for example, when re-installation of the printer driver is neces-
sary, uninstall the driver using the following procedure.

1 In [System Preferences...] of the Apple menu, open the [Print & Fax] or [Print & Scan] window.

% In Mac OS X 10.3/10.4, select [Macintosh HD] - [Applications] - [Utilities], then open the [Printer Set-
up Utility] window.

2 Select the printer you want to delete, then click [-] (or [Delete]).

The selected printer is deleted.

3 Close the [Print & Fax] or [Print & Scan] window.

4 Select [Macintosh HD] (hard disk of the system) in which you installed the printer driver, then select [Li-
brary] - [Printers] - [PPDs] - [Contents] - [Resources] ([Resources] in Mac OS X 10.5 or later, each lan-
guage folder in [Resources] in Mac OS X 10.3/10.4). Then, drag the gz file of this machine to [Trash].

5 Delete unnecessary files from [Library] - [Printers].

% Open [Library] - [Printers] - [KONICAMINOLTA], then drag the folder of this machine to [Trash].

6 In Mac OS X 10.3/10.4/10.5, open [Library] - [Recipients], then drag the pkg file of this machine to 
[Trash].

7 Restart the computer.

Uninstallation of the printer driver is then completed.
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4 Printing without Using the Printer Driver

4.1 Directly printing from the computer (Direct Print)

Direct Print
Direct Print is a function that directly sends files on your computer to this machine to print them without using 
the printer driver. You can print a file stored on your computer by specifying it using Web Connection.

This function is available for file types PDF, Compact PDF, JPEG, TIFF, XPS, Compact XPS, Open XPS, 
OOXML (.docx/.xlsx/.pptx), and PPML (.ppml/.vdx/.zip).

Tips
- However, the encrypted PDF file cannot be printed.

- Application software programs that offer the same function as Direct Print of Web Connection through 
simpler operations include Direct Print. Features such as printing through drag-and-drop to the desk-
top icon, printing using the [Send To] menu in Windows, and automatic printing using a hot folder (print 
monitoring folder) are available. You can also register multiple job settings in which print settings are 
configured. Direct Print can be downloaded from the utility software download page that is displayed 
by selecting [PageScope Utilities] in the Drivers & Utilities CD-ROM menu. For details, refer to the Di-
rect Print manual.

How to use Direct Print
Connect to Web Connection using a Web browser, then specify the file you want to print.

1 Access to the Web Connection using the Web browser.

% Enter the IP address of this machine in the URL field of the Web browser, then press the Enter key 
on the keyboard. 
http://<IP address of this machine>/

2 Log in with the account of a public user or registered user.

3 In the [Print] tab, click [Direct Print].

4 Click [Browse] to select a file to print, then click [Send].

The file is sent and printed.

Related setting
- You can configure print settings to directly print the OOXML (.docx/.xlsx/.pptx) file. 

To configure settings: [Utility] - [User Settings] - [Printer Settings] - [OOXML Print Settings]

- You can specify the method for determining the paper size when directly printing TIFF, JPEG, or PDF 
files. 
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [Paper Setting] - [TIFF Image Paper 
Setting] (default: [Priority Paper Size])
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Printing from a USB memory device
By connecting a USB memory device to this machine and specifying a file stored in the USB memory device, 
you can print the file.

This function is available for file types PDF, Compact PDF, JPEG, TIFF, XPS, Compact XPS, Open XPS, 
OOXML (.docx/.xlsx/.pptx), and PPML (.ppml/.vdx/.zip).

Tips
However, the encrypted PDF file cannot be printed.

Related setting (for the administrator)
You can specify whether to enable or disable printing data from USB memory. 
To configure settings: [Utility] - [Administrator Settings] - [System Settings] - [Folder Settings] - [External 
Memory Function Settings] - [Print Document] (default: [ON]).

Supported USB memory devices
USB memory devices that have the following specifications can be connected to this machine.

Tips
Note the following points when connecting a USB memory device to this machine.

- Use the USB connector on the side that is near the Control Panel.

- Do not disconnect the USB memory device while saving a file to the USB memory or printing a file in 
the USB memory.

- Use only a USB memory device on this machine. Do not use other USB devices (such as a hard disk 
unit or USB switching hub).

- Do not connect or disconnect the USB memory device when the hourglass is displayed in the Control 
Panel while this machine is active.

- Do not disconnect the USB memory device directly after connecting it.

Item Specifications

Supported media USB memory device (USB 2.0 supported)

File system FAT32 
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Printing procedure

1 Connect a USB memory device to the USB port of this machine.

2 Tap [Document Print/Delete].

3 Tap [External Memory].

4 Select a file to print, then tap [Print].

% Tap [Up] to move upward.

% Tap [Open] to open the folder and move downward.

5 If necessary, change print settings, then tap [Print].

Related setting
- You can configure print settings to directly print the OOXML (.docx/.xlsx/.pptx) file. 

To configure settings: [Utility] - [User Settings] - [Printer Settings] - [OOXML Print Settings]

- You can specify the method for determining the paper size when directly printing TIFF, JPEG, or PDF 
files. 
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [Paper Setting] - [TIFF Image Paper 
Setting] (default: [Priority Paper Size])

Settings Description

[Paper Size] Select the size of paper for printing. This can be specified when the selected 
file type is TIFF or JPEG.

[Duplex] Select whether or not to print data on one side or both sides of sheets of paper. 
To print data on both sides, select the binding position. 

[Finishing] - [Collate] When printing data by multiple copies, select whether or not to feed out copies 
separately one by one like "12345", "12345", and "12345". 
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